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About this guide

Revision history

Revision Date Description

B.0 December 2015 | Updates include:

e Combination of define and assign functions into a
single Plate tab

* Display of VeriFlex" Zones on plate layout

e Real-time data monitoring in the Run tab

e Security, Audit, and E-Signature (SAE] features

e Implementation of locked workflow

e Selection of an instrument before starting a run

e Ability to select multiple targets in the results view

e Various minor changes to the user interface

A0 April 2015 New document.

Scope of the guide

This guide is intended to help users get started with design and analysis of

experiments in the QuantStudio™ Design and Analysis desktop Software.

The software includes multiple options for many steps. This guide presents a single,
straightforward procedure for setup and analysis of each experiment type. Alternative
options and shortcuts are included in Appendix A, “Alternative procedures and
shortcuts for setting up an experiment”.

Also, the guide directs the user to the desktop software Help system for step-by-step
instructions for procedures that are not routinely performed by the user.
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General procedures to set up and
run experiments

B Setupanexperiment ...............oiiiiuiiiiiiiiii i 9
B Preparereactions .......... ...t 17
B Run an experiment from the desktop software ........................... 19

Set up an experiment

This section describes the general procedures to set up an experiment in the desktop
software. For setup information for a specific experiment type, see:

* “Set up a Standard Curve experiment in the software” on page 40

* “Set up a Relative Standard Curve experiment in the software” on page 48
* “Set up a Comparative CT experiment in the software” on page 50

* “Set up a Genotyping experiment in the software” on page 59

* “Set up the Presence/Absence experiment in the software” on page 68

* “Set up a Melt Curve experiment in the software” on page 74

* “Set up a custom experiment in the software” on page 80

Create or open an In the Home screen:

experiment . Create a new experiment.
To Action
Create an Click Create New Experiment.

experiment without
preexisting settings

Create an 1. Select Create New Experiment » Template.
experimentfroma | 2 Navigate to and select the desired file, then click Open.
system template Template files are installed with the software in:
<drive>:\Program Files (x86)\Applied
BioSystems\QuantStudio Design & Analysis
Software\templates,

where <drive> is the drive on which the software is
installed.

d Open an existing experiment.
a. Click Open.

QuantStudio™ Design and Analysis desktop Software User Guide 9



Chapter 1 General procedures to set up and run experiments

Set up an experiment

Workflow bar

Enter experiment

properties

Confirm or edit
the experiment
method

10

b. Navigate to and select the desired file, then click Open.

Continue to “Enter experiment properties” on page 10.

The workflow bar is used for navigation through experiment design and analysis.

Properties Method Plate Run Results Export

In the Properties tab:

1.

(Optional) Modify the default experiment Name.

The experiment Name determines the file name of the experiment. However,
when you save your experiment, changes to the experiment name from the
Properties tab do not update the file name. To change the file name after an initial
save, select 0; Save » Save as....

(Optional) Enter or scan a Barcode.

Note: Click in the Barcode field before using a barcode scanner.
(Optional) Enter a User name and Comments.
Select an Instrument type, Block type, Experiment type, Chemistry (reagents),

and Run Mode (Fast or Standard) from the drop-down lists.

Note: Selecting the experiment type defines the available options for the
experimental setup. See the “Experiment definitions” on page 11 for the
parameters defined in each experiment type.

(Optional) Click Manage chemistry details (see “Enter reagent information” on
page 10).

(Optional) Click U; Save or select U; Save » Save as... to save the experiment
(-edt) file before continuing.

Click Next to advance to “Adjust method parameters” on page 81.

Enter reagent information

Refer to the software Help system for step-by-step instructions for entering reagent
information.

In the Method tab:

(Optional) Adjust the reaction volume.

(Optional) Edit the default run method (thermal protocol) (see “Adjust method
parameters” on page 81).

The default run method has been optimized for TagMan™ assays and a broad
range of other reagents.

QuantStudio™ Design and Analysis desktop Software User Guide



Define samples
and targets or
SNP assays

Chapter 1 General procedures to set up and run experiments
Set up an experiment

These are general instructions. For specific instructions for each experiment type, see
the appropriate chapter in this guide.

Refer to the software Help system for step-by-step instructions for defining samples
and targets or SNP assays.

(Optional) Select ~ Action » Save to Library to save a sample, target, or SNP assay to
its respective library.

Experiment definitions

The parameters you can define vary by experiment type.

Experiment Type

Biological Passive Reference and
Targets SNP Assays Samples Replicate Endogenous
Reference
Groups Controls

Standard Curve

v

Relative Standard
Curve

v v

Comparative Ct

v v

S L

Melt Curve

Genotyping »./

Presence / v

Absence

Custom v v

AN NN NN NN
AN NN NN NN

Manually define a sample
In the Plate tab:

1. Click Advanced Setup.

2. Inthe Samples table, click Add.

3. (Optional) Click a cell to edit Color or Sample Name.
4. (Optional) Click = in the table header to add a Custom Attribute column.
a. Click the Custom Attribute column header, then edit the header with a new
sample attribute.
b. Click a Custom Attribute cell in the table, then enter a sample definition.
5. (Optional) Click Y to delete a sample from the table.

QuantStudio™ Design and Analysis desktop Software User Guide 11
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Chapter 1 General procedures to set up and run experiments

Set up an experiment

Manually define a target

edit Color, Name, Reporter dye, Quencher, or to add

In the Plate tab:
1. Click Advanced Setup.
2. In the Targets table, click [+] Add.
3. (Optional) Click a cell to
Comments.
4.

(Optional) Click X to delete a target from the table.

Manually define a SNP assay

Only Genotyping experiments contain SNP assay options.

In the Plate tab:

1.

2.

Click Advanced Setup.

In the SNPs table, click Add.

In the New SNP Assay dialog box, enter:

¢ SNP Assay Name

e Color

* Assay ID

¢ Gene Symbol

¢ Gene Name

e NCBI SNP Reference
e Allele 1 Name or Bas
e Allele 2 Name or Bas
¢ Context Sequence

e Comments
Click OK.

(Optional) Click X to de

es(s), Color, Reporter, and Quencher

es(s), Color, Reporter, and Quencher

lete a SNP assay from the table.

Define biological replicate groups

Biological Replicate Groups can be defined in Standard Curve, Relative Standard
Curve, Comparative Cr, and custom experiments.

In the Plate tab:
1. Click Advanced Setup.
2. In the Biological Replica
3. (Optional) Click a cell to
4. (Optional) Click X to de

te Groups table, click Add.
edit color, name, or comments.

lete a biological replicate group from the table.

QuantStudio™ Design and Analysis desktop Software User Guide



Assign samples,
targets or SNP
assays, and tasks
to wells

Chapter 1 General procedures to set up and run experiments
Set up an experiment

These are general instructions. For specific instructions for each experiment type, see
the appropriate chapter in this guide.

Refer to the software Help system for step-by-step instructions for defining samples
and targets or SNP assays.

Note: Only Genotyping experiments contain SNP assay options.

Note: You can start a run without well assignments, but the amplification plots are
displayed only after wells are assigned in the software.

Select plate wells

Click the appropriate icon to access the ~ Plate Layout or the =~ Well Table.

e Inthe Plate Layout:

To Action
Select a single well Click a well in the plate
Select multiple wells Click-drag in the plate
Select contiguous wells Shift-click wells in the plate

Select non-contiguous wells | Ctrl-click wells in the plate

Select a column of wells Click a column header
Select all wells Click the top-left corner of the plate grid
Select a block of wells Click on a well to define a corner, then Shift-click

another well on the opposite corner

Deselect a single well Ctrl-click in the selected well

e Inthe Well Table:

To Action
Select a single well Click a row in the table
Select multiple wells Click-drag in the table
Select contiguous wells Shift-click rows in the table
Select non-contiguous wells Ctrl-click rows in the table
Deselect a single well Ctrl-click in the selected row

Assign samples, targets or SNP assays, and tasks to wells (Quick Setup)

Use the Quick Setup pane to assign well attributes by direct entry into the text fields
or by selecting user-defined samples and targets or SNP assays from the drop-down
lists (see “Manually define a sample” and “Manually define a target” or “Manually
define a SNP assay”).

Note: Only Genotyping experiments contain SNP assay options.

In the Plate tab:

1. Click Quick Setup.

2. Select plate wellsin the ~ Plate Layout or the =~ Well Table.

QuantStudio™ Design and Analysis desktop Software User Guide 13
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Chapter 1 General procedures to set up and run experiments

Set up an experiment

4,

Assign the well attributes for the selected well(s).

¢ Enter the names of the new sample and the new target or SNP assay into their
respective text fields.

* Select a user-defined sample and target or SNP assay from their respective
drop-down lists.

Note: Assign a task to the well(s) in the Advanced Setup pane (see “Assign a
task to wells” on page 14).

(Optional) Enter comments for the selected well(s).

Assign samples, targets or SNP assays, and tasks to wells (Advanced Setup)

Use the Advanced Setup pane to define and assign samples and targets or SNP assays
concurrently. See “Manually define a sample” and “Manually define a target” or
“Manually define a SNP assay” for detailed instructions on defining samples and
targets or SNP assays.

Note: Only Genotyping experiments contain SNP assay options.

In the Plate tab:
1. Click Advanced Setup.
2. Select plate wellsin the ~ Plate Layout or the =~ Well Table.
3. In the Samples table:
a. Select the check box of a sample to assign it to the selected well(s).
b. Define the sample (see “Manually define a sample®).
4. In the Targets or SNP Assays table:

a. Select the check box of a target or SNP assay to assign it to the selected
well(s).

b. Define the target or SNP assay (see “Manually define a target” or “Manually
define a SNP assay”).

c. Select a detection task from the Task column drop-down list (see “Assign a
task to wells” on page 14).

Assign a task to wells

In the Plate tab:
1. Click Advanced Setup.
2. Select plate wellsin the ~ Plate Layout or the =~ Well Table.

In the Targets or SNP Assays table, select the check box of a target or SNP assay.

Note: Only Genotyping experiments contain SNP assay options.
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Chapter 1 General procedures to set up and run experiments
Set up an experiment

4. Select a detection task from the Task column drop-down list.

Option Description

[T] Unknown (default) The well contains test samples with unknown
genotype.

[.] Negative Control / No The well contains water or buffer instead of

template control sample.

[5] standard The well contains samples with known standard

(Standard Curve and Relative quantities.

Standard Curve experiments Note: If you select Standard as the detection

only) task, enter the standard quantity in the Quantity
column.

D Positive Control Allele The well contains samples homozygous for allele

1/Allele 1 1.

a Positive Control Allele The well contains samples homozygous for allele

2/Allele 2 2.

|E Positive Control Allele The well contains samples heterozygous for

1/Allele 2 allele 1 and 2.

Internal positive control The PCR reaction contains a short synthetic DNA

(Presence/Absence experiments | template to distinguish between true negative

only) results (that is, the target is absent in the

samples) and negative results caused by PCR
inhibitors, incorrect assay setup, or reagent or
instrument failure.

Blocked IPC The well contains an IPC blocking agent, which
(Presence/Absence experiments | blocks amplification of the IPC.
only)

NAC - No amplification control | The PCR reaction contains an IPC blocking agent

(Presence/Absence experiments | instead of sample.

only) No amplification should occur in negative
control-blocked IPC wells because the reaction
contains no sample and amplification of the IPC
is blocked.

Custom task (if defined) The well contains reaction components that do
not match the default task selections.

Assign a biological replicate group to wells

Biological Replicate Groups can be assigned in Standard Curve, Relative Standard
Curve, Comparative Cr, and custom experiments.

In the Plate tab:

1. Click Advanced Setup.
2. Select plate wells using the ~ Plate Layout or the =~ Well Table.

3. In the Biological Replicate Groups table, select the check box of a biological
replicate group to assign it to the selected well(s).

QuantStudio™ Design and Analysis desktop Software User Guide 15



Chapter 1 General procedures to set up and run experiments
Set up an experiment

Save the Experiment files saved before a run have an .edt extension. After the run is complete,
experiment the experiment file containing the run data has an .eds extension.

1. Inany tab, click O; Save.

Note: The file name is created from the experiment Name entered in the
Properties tab. Changes to the experiment name in the Properties tab after the
first save do not update the file name.

2. (Optional) To change the file name:

e In the menu bar, select File » Save As.

e Inany tab, select U; Save » Save as....

See also “Set up an experiment using templates” on page 89.

Shortcuts for e Use sample and target or SNP assay definitions saved in a library (see “Sample,
experiment setup target, and SNP assay libraries” on page 84).
¢ Import some or all of an experiment setup:
To Action Setup information
Import sample and well Import a sample definition file - Well number
assignments (page 86)

- Sample name
- [Optional) Custom sample properties

Import samples, targets, and Import a plate setup file Plate setup information:
well assignments (page 87) - Well number

- Sample name

- Sample color

- Target name

- Dyes

- [Optional/ Other well information

Set up the plate layoutin a Paste from an *.xls file Plate setup information, as above
spreadsheet without saving to a | (page 88)
special format

or

Use a subset of the columns in
a plate layout spreadsheet

Import complete experimental | Create an experiment from a - Plate setup information, as above

setup template (page 89) - Reagent information

- Thermal protocol

- Analysis settings
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Prepare reactions

Prepare reactions

Good laboratory
practices for PCR
and RT-PCR

Guidelines for
handling samples
and reagents

Guidelines for
setting up the
reactions in the
plates or tubes

QuantStudio™ Design and Analysis desktop Software User Guide

See Appendix C, “Parts and materials” for information about compatible reagents and
required materials for PCR reactions.

Follow the manufacturer's instructions for preparing reactions.

Follow the other guidelines described in this section.

When preparing samples for PCR or RT-PCR amplification:

* Wear clean gloves and a clean lab coat (not previously worn while handling
amplified products or during sample preparation).

¢ Change gloves whenever you suspect that they are contaminated.
* Maintain separate areas and dedicated equipment and supplies for:
— Sample preparation and reaction setup.
— Amplification and analysis of products.
* Do not bring amplified products into the reaction setup area.
¢ Open and close all sample tubes carefully. Avoid splashing or spraying samples.
¢ Keep reactions and components capped as much as possible.
* Use a positive-displacement pipettor or aerosol-resistant barrier pipette tips.

¢ (lean lab benches and equipment periodically with 10% bleach solution or
DNAZap™ Solutions (Cat. no. AM9890).

* Use calibrated pipettors and aerosol-resistant tips.

¢ Follow the manufacturer's recommendations for the master mixes and assay
mixes to prepare reaction mixes.

* Include excess volume in calculations to provide excess volume for the loss that
occurs during reagent transfers.

¢ Use TE buffer or water to dilute samples and any standards.

¢ Use care when diluting samples and standards. Mistakes or inaccuracies in
making the dilutions directly affect data accuracy.

* Keep the dilutions and assay mix protected from light, in the freezer, until you
are ready to use it. Excessive exposure to light may affect the fluorescent probes
or dyes.

¢ Prior to use:
— Mix the master mix thoroughly by swirling the bottle.

— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend
the samples by vortexing, then centrifuge the tubes briefly.

¢ Follow the guidelines in “Good laboratory practices for PCR and RT-PCR” on
page 17.

* Ensure that the arrangement of the PCR reactions matches the plate layout
displayed in the QuantStudio™ desktop Software.

17
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Prepare reactions

¢ Confirm that the liquid in each well is at the bottom of the well and free of
bubbles. If it is not, centrifuge the plate again.

* Ensure that plates or tubes are properly sealed.

* Keep the reaction plate or tubes at 4°C, in the dark, until you are ready to load it
into the instrument.

¢ Keep the bottom of the plate clean. Fluids and other contaminants on the bottom
of the plate can contaminate the sample block and cause an abnormally high
background signal.

¢ If necessary, use a permanent marker or pen to mark a tube and the side of a
plate. Do not use fluorescent markers.
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Run an experiment from the desktop software

Run an experiment from the desktop software

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block temperature can reach 100°C. Allow it to cool to room
temperature before handling.

1. Open an experiment (.edt) file in the desktop software.

2. Load the plate.
a. Touch & to eject the instrument drawer.

b. Load the plate onto the plate adaptor so that:
e Well Al of the plate is in the top-left corner of the plate adapter.
¢ The barcode faces the front of the instrument.

IMPORTANT! Plates should be loaded and unloaded by trained operators
who have been warned of the moving parts hazard.

Note: (For 96-well 0.2-mL blocks only) Do not remove the black plate adapter
before loading a plate or strip tubes. Strip tubes may fit loosely in the
adapter, but when the drawer closes, the heated cover will apply the
appropriate pressure to seat the tube strips securely in the adapter.

Note: The 384-well and 96-well Fast (0.1-mL) block configurations do not
require a plate adapter.

c. Touch 4 to close the instrument drawer.

3. In the Run tab of the desktop software, click START RUN.

Note: If multiple instruments are connected on a local area network, first select
the appropriate instrument from the drop-down list.

4. When the run is complete, touch ﬁ on the instrument home screen, unload the
plate from the instrument, and close the drawer.

The experiment (.eds) file in the desktop software is automatically updated with
experiment data when the run is complete.

QuantStudio™ Design and Analysis desktop Software User Guide 19
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Chapter 1 General procedures to set up and run experiments
Run an experiment from the desktop software

If the connection between the instrument and the desktop software is interrupted
during the run, the instrument completes the run. However, the experiment data must
be transferred via a USB drive (see “Transfer files from the instrument” on page 93).
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m Confirm accurate dye signal using the Multicomponent Plot ............... 31
B Determine signal accuracy using the Raw DataPlot ....................... 33
B Review the flagsinthe QCSummary ........... ... ... ... ..o i, 34
B Configure analysis settings . ..., 34
B About overriding the calibrationdata ... 36
B Exportexperimentsorresults ............... ... ... ..o oo 37

This section includes information about viewing results and configuring analysis
settings for all experiment types. For analysis information for a specific experiment
type see the corresponding chapter.

Refer to the software Help system for step-by-step instructions for procedures that are
not described in this guide.
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Overview of the Results tab

View and analyze experiment data in the Results tab. In the Results tab, two
additional tools are displayed at the right-end of the workflow bar (Figure 1).

Figure 1 Workflow bar in the Results tab

¢ C(lick Analyze to analyze data after omission of wells or changes to the analysis

settings

e Click £¥ to access analysis settings (varies by experiment)

oS -0

@_

Figure 2 Plot pane

@ Plot toolbar (left to right): e Configure plot properties
e Zoom in ¢ Show/hide plot legend
e Zoom out e Configure plot settings
e Print plot image @ Plot selection list (varies by experiment)
* Copy plot image (@) Expand/contract the plot pane display
e Save plot as image file @ Plot legend
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Figure 3 Plate Layout

@ Expand/contract the Plate Layout display

(layout is expanded in this figure)

@ View: Select well properties to display
(3 Plate Layout toolbar (left to right):

e Zoom in

@—: View | v Groupby v
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Figure 4 Well Table

@ Expand/contract the Well Table display

lag  Sample Na.. Target Na.

KAz

KAz

KAz

KAz

KAz

Task

NTC

NTC

STANDA.

STANDA.

STANDA.

Dyes

FAM-NF.

FAM-NF.

FAM-NF.

FAM-NF.

FAM-NF.

(table is expanded in this figure)

(@ View: Select well properties to display
@ Group by: Select a parameter by which to

group well rows
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Undeter.

Undeter.

35.087

35.009

21379

35.204

35.204

31624

0508

0508

0167

e Zoom out
¢ Fit plate to window
¢ Display Plate Layout
e Display Well Table

Quantity Quantity M... Quantity SO Amp Status

10.000

10.000

100.000

No Amp

No Amp

(&) Well Table toolbar (left to right):

e Expand grouped rows
¢ Collapse grouped rows
¢ Display Plate Layout

¢ Display Well Table
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General workflow for analysis of experiments

When the run is complete, the QuantStudio™ desktop Software automatically
analyzes the data using the default analysis settings, then displays the Amplification

Plot in the Results tab.

View the Amplification Plot to confirm or correct threshold and
baseline settings (page 25)

v

Assess the experiment plot for the experiment
(refer to the appropriate chapter]

v

Review data for outliers and omit wells, if necessary (page 29)

v

[Optional/View the Multicomponent Plot (page 31)
v

(Optional/View the Raw Data Plot (page 33)
v

[Optional] Review flags in the QC Summary (page 34)
v

[Optional] Configure the analysis settings (page 34)

IMPORTANT! After omission of wells or configuration of analysis settings, click

Analyze to reanalyze the experiment.

Guidelines for viewing and analyzing results

* Refer to the software Help system for information about adjusting the views in

the Results tab.

* Toreanalyze the data, select all the wellsin the  Plate Layout, then click

Analyze.

¢ To enable auto-analysis of data after a run, select
Tools » Preferences » Experiment, then select Auto Analysis.
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Assess results in the Amplification Plot

Assess results in the Amplification Plot

About the The Amplification Plot displays sample amplification as a function of cycle number or
Amplification Plot well. View the amplification plot to:

e Confirm or correct baseline and threshold values.

¢ Identify outliers.

* Identify and examine abnormal amplification, including:

— Increased fluorescence in negative control wells.

— Absence of detectable fluorescence at an expected cycle.

Note: If you notice abnormal amplification or a complete absence of
fluorescence, refer to the instrument user guide for troubleshooting
information.

There are three plots available. Each plot can be viewed as a linear or log;g graph.

Table T Amplification plots

Plot type

Description

Use to

ARn vs Cycle

ARn is the magnitude of normalized
fluorescence signal generated by
the reporter at each cycle during the
PCR amplification.

Identify and examine irregular
amplification and to view
threshold and baseline values
for the run.

Rn vs Cycle

Rn is the fluorescence signal from
the reporter dye normalized to the
fluorescence signal from the passive
reference.

Identify and examine irregular
amplification.

Ctvs Well

Ctis the PCR cycle number at which
the fluorescence meets the
threshold in the amplification plot.

Locate outlying amplification
(outliers).

QuantStudio™ Design and Analysis desktop Software User Guide
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Assess results in the Amplification Plot

Assess the overall Inthe Results tab:

shape of the If no data are displayed, click Analyze.
Amplification Plot
curves 1. Select Amplification Plot (default) from the drop-down list.

2. Click to configure the plot:

* Plot Type: ARn vs Cycle (default)
¢ Graph Type: Log (default)
e Plot Color: WELL (default)

The Amplification Plot is displayed for the selected well(s) inthe  Plate
Layout.

® ©@®

Figure 5 Typical amplification plot

A typical amplification curve has four distinct sections:
@ Baseline @ Linear phase

(@ Exponential ([geometric) phase (® Plateau phase

Confirm or correct In the Results tab:

threshold settings 1. Select Amplification Plot (default) from the drop-down list.

2. Click to configure the plot:

* Plot Type: ARn vs Cycle (default)
* Graph Type: Log (default)
e Plot Color: WELL (default)

The Amplification Plot is displayed for the selected well(s) inthe  Plate
Layout.

3. (Optional) Adjust the threshold.

¢ C(lick-drag the threshold bar into the exponential phase of the curve.
¢ Configure the Ct analysis settings (see page 35).
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Examples of threshold settings

Chapter 2 General procedures to review results
Assess results in the Amplification Plot

The threshold should be set in the exponential phase of the amplification curve. A
threshold set above or below the optimum can increase the standard deviation of the

replicate groups.

Threshold setting
evaluation

Example

Threshold set correctly.

Threshold set too low.

Threshold set too high.

QuantStudio™ Design and Analysis desktop Software User Guide
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Assess results in the Amplification Plot

Confirm or correct
baseline settings

28

In the Results tab:

1. Select Amplification Plot (default) from the drop-down list.

2. Click to configure the plot:

* Plot Type: ARn vs Cycle (default)
* Graph Type: Linear (default)
e Plot Color: WELL (default)

The Amplification Plot is displayed for the selected well(s) inthe  Plate
Layout.

The start and end cycles (green and red squares, respectively) that are used to
calculate the baseline are displayed on the Amplification Plot for that well.

3. (Optional) Adjust the start and end cycle values for the baseline (see “About the
CT settings” on page 35).

Figure 6 Example of correct baseline

The end cycle (indicated by the red squares) should be set a few cycles before the cycle number
where significant fluorescent signal is detected.
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Omit outliers from  Outlier wells have Ct values that differ significantly from the average for the
analysis associated replicate wells. To ensure Cr precision, omit the outliers from the analysis.

In the Results tab:

1. Select Amplification Plot (default) from the drop-down list.

2. Click  to configure the plot:

* Plot Type: Ct vs Well
* Graph Type: Linear (default)
e Plot Color: WELL (default)

The Cr values are displayed for the selected well(s) in the  Plate Layout.

3. Click to examine the Well Table for outliers.
a. Select Group by » Replicate.

b. Identify outliers in each replicate group.
Outlier wells typically have one or more QC flags.

4. Omit outliers.
e In the Well Table, select Omit in outlier rows of the table.
or

¢ Inthe  Plate Layout, right-click a well, then select Omit.

5. Click Analyze to reanalyze the experiment data with any outliers removed.

Optimize display In the Results tab:
of negative 1
controls in the

Amplification Plot 2. Click to configure the plot:

. Select Amplification Plot (default) from the drop-down list.

e Plot Type: ARn vs Cycle

¢ Graph Type: Linear

¢ Plot Color: TARGET

* Deselect Threshold and Show: Baseline Start/End

3. Ineither the  Plate Layoutor  Well Table, select the negative control wells
(wells that should not have amplification for a particular target).

4. Click  (configure plot properties), then select the Y Axis tab. Configure the
plot.

a. Deselect Auto-adjust range.
b. Enter Minimum value of —1.

c. Enter Maximum value of 2.
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d. Click Save.

Figure 7 Example Amplification Plot display of negative controls
The linear plot enables the display of the Amplification Plot for negative controls as smooth
lines. The expanded Y axis enables display of low levels of amplification.

Assess results in the Well Table view

About the Well
Table

The  Well Table displays data for each well in the reaction plate, including:

* The sample name, target name, task, and dyes

* The calculated threshold cycle (Cr), Cr standard deviation, and normalized

fluorescence (Rn)

* Specific experimental values (for example, quantities or calls)

¢ Comments

* Flags

Group or sort the Well Table as described in the following table.

Note: You can select only one category at a time.

Group category

Description

Notes

Replicate

Grouped by replicate

For example, negative controls, standards,
and samples

Examine the Cyor quantity values for each
replicate group to assess the precision of Ct
values.

Flag

Grouped as flagged and unflagged wells

A flag indicates that the software has found a
potential error in the flagged well.

Refer to the software Help system for more
information about flags.

30
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Group category Description Notes
Cr Grouped by Cr value: e ACtvalue <8 indicaltes that the.re may be
e Low (Cr <24) too much template in the reaction.
. e A Cyvalue >35 indicates a low amount of
M.edlum (Cr from 24 to 30] target in the reaction; for Cy values >35,
* High (Cy>30) expect a higher standard deviation.
e No CT

Confirm accurate dye signal using the Multicomponent Plot

About the

Multicomponent

Plot

View and assess
the
Multicomponent

Plot

The Multicomponent Plot displays the complete spectral contribution of each dye
over the duration of the PCR run.

Use the Multicomponent Plot to:

¢ Confirm that the signal from the passive reference dye remains unchanged
throughout the run.

* Review reporter dye signal for spikes, dips, and/or sudden changes.

¢ Confirm that no amplification occurs in the negative control wells.

In the Results tab:

If no data are displayed, click Analyze.
1. Select Multicomponent Plot from the drop-down list.
2. Click  to configure the plot:

e Plot Color: DYE

The Multicomponent Plot is displayed for the selected well(s) in the ~ Plate
Layout.
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Confirm accurate dye signal using the Multicomponent Plot

3. Select wells one at a time in the Plate Layout, and examine the
Multicomponent Plot for the following:

Plot characteristic

Description

Passive reference dye

The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

Reporter dye

The reporter dye fluorescence level should display a flat
region corresponding to the baseline, followed by a rapid
rise in fluorescence as the amplification proceeds.

Irregularities in the
signal

Spikes, dips, and/or sudden changes in the fluorescent
signal may have an impact on the data.

Negative control wells

There should not be any amplification in the negative
control wells.

Figure 8 Example Multicomponent Plot (single well)
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Determine signal accuracy using the Raw Data Plot

About the Raw The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
Data Plot each optical filter during each cycle of the real-time PCR.

View the Raw Data Plot to confirm a stable increase in signal (no abrupt changes or
dips) from the appropriate filter.

View and assess In the Results tab:
the Raw Data Plot If no data are displayed, click Analyze.

1. Select Raw Data Plot from the drop-down list.
The Raw Data Plot is displayed for the selected well(s) in the ~ Plate Layout.

2. Click to display the Show Cycle scale.

3. Click-drag the Show Cycle pointer from cycle 1 to cycle 40, and confirm that
characteristic signal growth is seen for each filter.

™

The filter set for each system dye is provided in the QuantStudio™ 3 and 5 Real-
Time PCR Systems Installation, Use, and Maintenance Guide (Pub.
no. MAN0010407).

Figure 9 Example Raw Data Plot

QuantStudio™ Design and Analysis desktop Software User Guide
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Review the flags in the QC Summary

The QC Summary displays a list of the software flags, including the flag frequency
and location.

In the Results tab:

If no data are displayed, click Analyze.

1. Select QC Summary from the drop-down list.

2. Review the Flag Details table and the summary.

The Flag Details table identifies any wells that triggered a flag in the Well
column.

3. (Optional) In the Flag Details table, click each flag to display information about
the flag.

Refer to the software Help system for more information about the flag.

Configure analysis settings

About the analysis
settings

View and
configure the
analysis settings

34

This section describes the analysis settings that apply to all experiment types, unless
otherwise noted.

Analysis settings determine how the baseline, threshold, and threshold cycle (Cr) are
calculated, what flags are enabled, and other analysis options that are specific to an
experiment type. The default analysis settings are different for each experiment type.

We recommend analyzing the experiment with default analysis settings. If the default
analysis settings are not suitable for the experiment, change the settings in the
Analysis Settings dialog box, then reanalyze the experiment.

Save changed analysis settings to the Analysis Settings Library.

See also:
¢ “About the CT settings” on page 35
e “About the flag settings” on page 36
* “About Advanced Settings” on page 36
e “About the Standard Curve settings” on page 44
* “About relative quantification settings” on page 57
e “About call settings for Genotyping experiments” on page 64
e “About call settings for Presence/Absence experiments” on page 72

e “About Melt Curve settings” on page 77

In the Results tab:

1. Click £¥ (in top-right corner).

2. View and, if necessary, configure the analysis settings.

Refer to the software Help system for step-by-step instructions for adjusting
analysis settings.
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About the Cy
settings

Table 2 Cy Settings

Chapter 2 General procedures to review results
Configure analysis settings

3. Click Apply.
4. Click Analyze to reanalyze to experiment with the new settings.

5. (Optional) To save the analysis settings in the Analysis Settings Library, click
Save....

6. (Optional) To return to the default settings, click Revert.

The default Cy settings are appropriate for most applications. Configuration of the
settings is an option for analysis of atypical or unexpected experimental data.

Refer to the software Help system for step-by-step instructions for adjusting the Ct
settings.

The Cr Settings feature is not available for Melt Curve experiments without a PCR
stage.

Setting

Description

Data Step Selection

Determines the stage/step combination for Ct analysis (when there is more than one
data collection point in the run method).

Algorithm Settings -
Baseline Threshold

The Baseline Threshold algorithm is used to calculate the Ct values.

This algorithm is an expression estimation algorithm that subtracts a baseline
component and sets a fluorescence threshold in the exponential region.

Algorithm Settings -
Relative Threshold

The relative threshold (Crt) algorithm is used to calculate the Cr values.

Default Cy Settings

Determines how the Baseline Threshold algorithm is set. The Default Cy Setting is
used for targets unless they have custom settings.

See Table 3 for recommendations on adjusting baseline and threshold.

Ct Settings for Target

e Selected Default Settings uses the Default Ct Settings to calculate the Cy values
for the target.

e Deselected Default Settings allows manual setting of the baseline or the
threshold.

See Table 3 for recommendations for adjusting baseline and threshold.

Table 3 Recommendations for manual threshold and baseline settings

Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
e Above the background.
e Below the plateau and linear phases of the amplification curve.

e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescence signal is detected.
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About the flag
settings

About Advanced
Settings

Use the Flag Settings tab to:
* Adjust the sensitivity so that more wells or fewer wells are flagged.
¢ Change the flags that are applied by the software for each experiment type.

Refer to the software Help system for step-by-step instructions for configuring the flag
settings.

Use the Advanced Settings tab to change baseline settings in individual wells.

Refer to the software Help system for step-by-step instructions for adjusting the
advanced settings.

The Advanced Settings feature is not available for Melt Curve experiments.

About overriding the calibration data

36

Each experiment (.eds) file stores the calibration data from the QuantStudio 3 or 5
Instrument on which it was run.

You can use calibration data from another QuantStudio” 3 or 5 Instrument for
analysis of your experiment.

The calibration data used must be from the same block type and instrument type
(QuantStudio " 3 Instrument or QuantStudio 5 Instrument). Calibration data from a
QuantStudio " 5 Instrument experiment can be used to override calibration data for a
QuantStudio ™ 3 Instrument experiment, but not vice-versa.

Refer to the software Help system for step-by-step instructions for overriding
calibration data.
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Export experiments or results

Options for
publishing the
analyzed data

Export experiments or results

Refer to the software Help system for step-by-step instructions for exporting

experiments or results.

To Action
Save a plot as an image file Click B
Print a plot Click =
Copy a plot to the clipboard Click

Export data

Click Export

Print the plate layout

Select File » Print...

Create slides

Select File » Send to PowerPoint...

Print a report

Select File » Print Report...

Export configurations

Data type

Description

File format or application

Plate setup files for

Plate setup information (such as the well

e .txt (for future import)

Standard Curve, Comparative Ct, and Melt
Curve experiments)

future experiments number, sample name, sample color, target e xls
name, dyes, and other reaction plate
o .xlsx
contents)
Analyzed data for QuantStudio™ format * .txt
further analysis e xls
e .xlsx
RDML format (for Standard Curve, Relative .rdml
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Getting started with Standard Curve

experiments

About Standard Curve experiments ............... ... ... il 38
Set up a Standard Curve experiment in the software ...................... 40
Set up and run the PCRreactions .............. ... ... .. . i 41
Reviewresults ....... ... ... .. 42

About Standard Curve experiments

Overview A Standard Curve experiment is used to determine absolute target quantity in
samples.

In a Standard Curve experiment:

1.

38

The software measures amplification of the target in a standard dilution series
and in test samples.

The software generates a standard curve using data from the standard dilution
series.

Using the standard curve, the software interpolates the absolute quantity of
target in the test samples.

QuantStudio™ Design and Analysis desktop Software User Guide



Reaction types

Compatible PCR
options

Chapter 3 Getting started with Standard Curve experiments
About Standard Curve experiments

Multiple targets can be assayed in a standard curve experiment, but each target
requires its own standard curve.

Table 4 Reaction types for Standard Curve experiments

Reaction type (task) Sample description

Standard A sample that contains known quantities of the target
Note: The target should be previously quantified in the
standard sample using an independent method.

Unknown Test sample

No-template control (NTC) | Water or buffer

No amplification of the target should occur in NTC wells.

¢ The precision of quantification experiments improves as the number of replicate

reactions increases. Set up the number of replicates appropriate for the
experiment.

* For accurate and precise efficiency measurements, set up the standard dilution

series with at least five dilution points over a broad range of standard quantities,
4 to 6 logs (10*- to 10°-fold). A concentrated template, such as a plasmid or PCR

product, is best for this purpose.

If the amount of standard is limited, the target is in low abundance, or the target
is known to fall within a given range, a narrow range of standard quantities may

be appropriate.

Table 5 PCR options for Standard Curve experiments

Single- or multiplex PCR PCR or RT-PCRI"

Reagent system

Singleplex PCR
1-step RT-PCR

TagMan”

Multiplex SYBR" Green

2-step RT-PCR

1" RT-PCR: reverse transcription-PCR

QuantStudio™ Design and Analysis desktop Software User Guide
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Set up a Standard Curve experiment in the software

Set up a Standard Curve experiment in the software

1. In the Home screen, create or open an experiment.
2. In the Properties tab, enter the information for the experiment.

3. In the Method tab, enter the reaction volume for the experiment.

For most experiments, the default run method is appropriate.

4. Setup standard dilutions in the Plate tab.
a. Select  Action » Define and Set Up Standards.

b. Select Singleplex or Multiplex from the Model drop-down list.
c. (Optional) Select the target.

d. Enter the parameters for the dilution series.
* Number of dilution points: 5 recommended
e Number of replicates: 3 recommended

¢ Starting quantity: enter the highest or lowest standard quantity,
without units (the quantity can be expressed as copies, copies/pL, or

ng/ulL)
e Serial dilution factor:

— If the starting quantity is the highest value, select a serial factor
from 1:10 to 1:2.

— If the starting quantity is the lowest value, select a serial factor from
2x to 10x.

e. Select and arrange the wells for the standards.

® Select to arrange standards in columns or rows.

¢ Select Automatically Select Wells for Me or select Let Me Select Wells,
then drag the cursor to select the appropriate block of wells.

f. Click Apply.
Alternatively, see “Assign the standard dilutions manually” on page 83.

5. Define and assign well attributes in the Quick Setup pane of the Plate tab.
a. Select wellsin the  Plate Layoutor the = Well Table.

b. Assign samples and targets to selected wells.
* Enter new sample and target names in their respective fields.
* Select previously defined samples and targets from their respective
drop-down lists.

Note: When you enter a new sample or target name in the Quick Setup
pane, the software automatically populates default values for Reporter
(FAM) and Quencher (NFQ-MGB) and assigns the task (m Unknown).
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Set up and run the PCR reactions

To change these default values, click Advanced Setup (see “Define samples
and targets or SNP assays” on page 11 or “Sample, target, and SNP assay
libraries” on page 84).

6. Assign plate attributes in the Quick Setup pane of the Plate tab.

a. In the Plate Attributes group, select the Passive Reference from the drop-
down list.

7. (Optional) Assign tasks in the Advanced Setup pane of the Plate tab.
a. Select wellsinthe  Plate Layout or the =~ Well Table.

b. In the Targets table, select the checkbox of a target, then select a task from
the drop-down list.

Reaction type Task
Unknown [test sample) m
No-template control N |

Note: You can define and setup standards in the Targets table: Select the
task of [5]] Standard, then enter the quantity for that target.

8. (Optional) Define and assign biological replicate groups in the Advanced Setup
pane of the Plate tab.

a. In the Biological Replicates Groups table, enter a name and select a color for
each biological replicate group.

b. Select wells, then select the checkbox of a biological replicate group to assign
it to the selected well(s).

In the Advanced Setup pane of Plate tab, ensure the Samples table contains:
® One sample for each dilution of an unknown sample

* (Optional) A standard sample for each target

Set up and run the PCR reactions

1. Assemble the PCR reactions, following the manufacturer's instructions for the
reagents, and following the plate layout set up in the software.

2. In the desktop software, open the appropriate experiment (.edt) file.
3. Load the reaction plate into the instrument and start the run.

See also:
* “Prepare reactions” on page 17

* “Run an experiment from the desktop software” on page 19
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Review results

General workflow
for analysis of
Standard Curve
experiments

About the

Standard Curve

Plot

View the Amplification Plot to confirm or correct threshold and

baseline settings (page 25)
v

Assess the Standard Curve Plot (page 43)
v

Review data for outliers and omit wells, if necessary (page 29)

v

[Optional/View the Multicomponent Plot (page 31)
v

[Optional/View the Raw Data Plot (page 33)
v

(Optional/ Review flags in the QC Summary (page 34)
v

[Optional] Configure the analysis settings (page 34)

IMPORTANT! After omission of wells or configuration of analysis settings, click
Analyze to reanalyze the experiment.

The Standard Curve Plot displays the standard curve for samples designated as
standards. The software calculates the quantity of an unknown target from the

standard curve.

Table 6 Results to evaluate in the Standard Curve Plot

Result Description Criteria for evaluation
Slope and The amplification efficiency is calculated | A slope close to -3.3 indicates optimal, 100% PCR
amplification | using the slope of the regression line in amplification efficiency.
efficiency the standard curve. Factors that affect amplification efficiency:
¢ Range of standard quantities - For accurate and
precise efficiency measurements, use a broad range
of standard quantities, 5 to 6 logs (10°- to 106-fold).
¢ Number of standard replicates - For accurate
efficiency measurements, include replicates to
decrease the effects of pipetting inaccuracies.
¢ PCRinhibitors - PCR inhibitors in the reaction can
reduce amplification efficiency.
RZ value The RZvalue is a measure of the closeness | ® Avalue of 1.00 indicates a perfect fit between the
(correlation | of fit between the regression line and the regression line and the data points.
coefficient) individual Cy data points of the standard e An RZvalue >0.99 is desirable.
reactions.
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The error can be used to calculate a
confidence interval (Cl) for the slope and
therefore the amplification efficiency.

Review results
Result Description Criteria for evaluation
Error The standard error of the slope of the Acceptable value is determined by the experimental

regression line in the standard curve. criteria.

Cy values The threshold cycle (Cq) is the PCR cycle A Ctvalue >8 and <35 is desirable.
number at which the fluorescence level
meets the threshold.

template in the reaction.

e A Cyvalue >35 indicates a low amount of target in
the reaction; for Cy values >35, expect a higher
standard deviation.

e A Cyvalue <8 indicates that there may be too much

View and assess In the Results tab:
the Standard If no data are displayed, click Analyze.
play y

Curve Plot

1.

2.

Select Standard Curve from the drop-down list.

Click  to configure the plot:

* Target: select the target of interest
e Plot Color: FLAG-STATUS, SAMPLE, TARGET, or TASK
* Selectall wellsinthe  Plate Layout

The Standard Curve Plot is displayed. The slope, R? value, amplification
efficiency, and error are displayed below the plot.

Confirm that the slope, R? value, amplification efficiency, and error meet the
experimental criteria.
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Review results

4. Visually check that all unknown sample Cr values fall within the standard curve
range.

5. Inthe  Well Table, use the Group By drop-down list to confirm that the Cy
values of all replicate samples meet the experimental criteria.

Figure 10 Example Standard Curve Plot

If the experiment does not meet the guidelines above, troubleshoot as follows:
* Omit wells (see “Omit outliers from analysis” on page 29).
or

* Repeat the experiment, adjusting the experimental setup to improve results.

See also “About the Standard Curve Plot” on page 42.

About the You can use the standard curve from another experiment and apply it to the current

Standard Curve experiment. The two experiments must be from the same instrument type, block type,

settings and run method. Use the Standard Curve Settings tab in the ¢ Analysis Settings to
import an external standard curve.

Refer to the software Help system for step-by-step instructions for adjusting the
Standard Curve settings.
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About Relative Standard Curve experiments

Overview The Relative Standard Curve experiment is used to determine relative target quantity
in samples.

In a Relative Standard Curve experiment:

1. The software measures amplification of the target of interest and of an
endogenous control target in a standard dilution series, in a reference (calibrator)
sample, and in test samples.

The endogenous control is a target that is expressed equally in all samples;
examples of endogenous controls are -actin, GAPDH, and 18S ribosomal RNA.
The software can algorithmically incorporate multiple endogenous control
targets in relative quantification calculations.

The reference sample is used as the basis for relative quantification results (or
1x sample). For example, in a study of drug effects on gene expression, an
untreated control is an appropriate reference sample.

2. The software generates standard curves for the target of interest and the
endogenous control using data from the corresponding standard dilution series.

3. Using the standard curves, the software interpolates the quantities of the target
of interest and the endogenous control in each sample. The target quantity in
each sample is then normalized to the sample's endogenous control quantity.

4. To determine the relative quantity of the target in test samples, the software
divides the normalized target quantity in the sample by the normalized target
quantity in the reference sample.

See “Relative quantitation: Relative Standard Curve vs Comparative CT” on page 48
for a comparison of this method to the Comparative Ct (AACt) method.
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Reaction types Relative Standard Curve experiments include the following reaction types for the
endogenous control target and each target of interest.

Table 7 Reaction types for Relative Standard Curve experiments

Reaction type (task) Sample description

Standard A sample that contains known quantities of the target

Note: The target should be previously quantified in the
standard sample using an independent method.

Reference sample The sample that is used as the basis for relative
quantification results

Unknown Test sample

No-template control (NTC) | Water or buffer

No amplification of the target should occur in NTC wells.

* The precision of quantification experiments improves as the number of replicate
reactions increases. Set up the number of replicates appropriate for the
experiment.

* For accurate and precise efficiency measurements, set up the standard dilution
series with at least five dilution points over a broad range of standard quantities,
4 to 6 logs (10*- to 10°-fold). A concentrated template, such as a plasmid or PCR
product, is best for this purpose.
If the amount of standard is limited, the target is in low abundance, or the target
is known to fall within a given range, a narrow range of standard quantities may

be appropriate.
Compatible PCR Table 8 PCR options for Relative Standard Curve experiments
options
Single- or multiplex PCR PCR or RT-PCR!" Reagent system
Singleplex PCR TagMan”
Multiplex 1-step RT-PCR SYBR" Green
2-step RT-PCR

[ RT-PCR: reverse transcription PCR
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About Comparative C; experiments

Overview

Reaction types

Compatible PCR
options

The Comparative Ct (AACt) experiment is used to determine relative target quantity

in samples.

In a Comparative Ct experiment:

1. The software measures amplification of the target of interest and of an
endogenous control target in a reference (calibrator) sample and in test samples.

The endogenous control is a target that is expressed equally in all samples;
examples of endogenous controls are $-actin, GAPDH, and 18S ribosomal RNA.
The software can algorithmically incorporate multiple endogenous control
targets in relative quantification calculations.

The reference sample is used as the basis for relative quantification results (or
1x sample). For example, in a study of drug effects on gene expression, an

untreated control is an appropriate reference sample.

2. The measurements for the target of interest are normalized to the endogenous

control.

3. To determine the relative quantity of the target in test samples, the software
compares the normalized Ct (ACrt) for the sample to the normalized Ct (ACr) for

the reference sample.

See “Relative quantitation: Relative Standard Curve vs Comparative CT“ on page 48
for a comparison of this method to the Relative Standard Curve method.

Comparative Ct experiments include the following reaction types for the endogenous

control target and each target

Table 9 Reaction types for Comparative Cy experiments

of interest.

Reaction type (task)

Sample description

Reference sample

The sample that is used as the basis for relative

quantification results

Unknown

Test sample

No-template control (NTC)

Water or buffer

No amplification of the target should occur in NTC wells.

The precision of quantification experiments improves as the number of replicate
reactions increases. Set up the number of replicates appropriate for the experiment.

Table 10 PCR options for Comparative Ct experiments

Single- or multiplex PCR

PCR or RT-PCRI"

Reagent system

Singleplex
Multiplex

PCR
1-step RT-PCR
2-step RT-PCR

TagMan™
SYBR™ Green

[ RT-PCR: reverse transcription PCR

QuantStudio™ Design and Analysis desktop Software User Guide

47



Chapter 4 Getting started with Relative Standard Curve and Compara-
tive Cr experiments
Relative quantitation: Relative Standard Curve vs Comparative CT

Relative quantitation: Relative Standard Curve vs Comparative Ct

Relative Standard Curve experiments and Comparative Cy (AACt) experiments have
the same purpose: to determine the relative quantity of a target of interest in a test
sample relative to a reference sample. Relative quantitation experiments are
commonly used to:

* Compare expression levels of a gene in different tissues.

¢ Compare expression levels of a gene in a treated sample and an untreated
sample.

¢ Compare expression levels of a gene of interest in different genetic backgrounds.

¢ Analyze the gene expression changes over time under specific treatment
conditions.

Table 11 Comparison of Relative Standard Curve and Comparative Ct experiments

Characteristic Relative Standard Curve Comparative Cy

Typical use Best for assays that have suboptimal PCR Best for high-throughput measurements of
efficiency. relative gene expression of many genes in many

samples.

Advantage Requires the least amount of validation * Relative levels of target in samples can be
because the PCR efficiencies of the target and determined without the use of a standard
endogenous control do not need to be curve, if the PCR efficiencies of the target
equivalent. and endogenous control are relatively

equivalent.

e Reduced reagent usage.

e More space available in the reaction plate.

Limitation A standard curve must be constructed for each | ¢ Suboptimal (low PCR efficiency] assays
target, which requires more reagents and more may produce inaccurate results.
space in the reaction plate. e Before you use the comparative Ct

method, we recommend that you
determine that the PCR efficiencies for the
target assay and the endogenous control
assay are approximately equal.

Set up a Relative Standard Curve experiment in the software

1. In the Home screen, create or open an experiment.
2. In the Properties tab, enter the information for the experiment.

3. In the Method tab, enter the reaction volume for the experiment.

For most experiments, the default run method is appropriate.

4. Setup standard dilutions in the Plate tab.
a. Select  Action » Define and Set Up Standards.
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b. Select Singleplex or Multiplex from the Model drop-down list.
c. (Optional) Select the target.

d. Enter the parameters for the dilution series.
e Number of dilution points: 5 recommended
e Number of replicates: 3 recommended

¢ Starting quantity: enter the highest or lowest standard quantity,
without units (the quantity can be expressed as copies, copies/uL, or

ng/uL)
¢ Serial dilution factor:
— If the starting quantity is the highest value, select a serial factor
from 1:10 to 1:2.

— If the starting quantity is the lowest value, select a serial factor from
2x to 10x.

e. Select and arrange the wells for the standards.
® Select to arrange standards in columns or rows.

* Select Automatically Select Wells for Me or select Let Me Select Wells,
then drag the cursor to select the appropriate block of wells.

f. Click Apply.
Alternatively, see “Assign the standard dilutions manually” on page 83.

5. Define and assign well attributes in the Quick Setup pane of the Plate tab.
a. Select wellsinthe  Plate Layout or the =~ Well Table.

b. Assign samples and targets to selected wells.
¢ Enter new sample and target names in their respective fields.
* Select previously defined samples and targets from their respective
drop-down lists.

Note: When you enter a new sample or target name in the Quick Setup
pane, the software automatically populates default values for Reporter
(FAM) and Quencher (NFQ-MGB) and assigns the task ([I] Unknown).

To change these default values, click Advanced Setup (see “Define samples
and targets or SNP assays” on page 11 or “Sample, target, and SNP assay
libraries” on page 84).

6. Assign plate attributes in the Quick Setup pane of the Plate tab.

a. In the Plate Attributes group, select a Passive Reference, Reference Sample,
and Endogenous Control from their respective drop-down lists.

7. (Optional) Assign tasks in the Advanced Setup pane of the Plate tab.
a. Select wellsin the  Plate Layout orthe = Well Table.
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b. In the Targets table, select the checkbox of a target, then select a task from
the drop-down list.

Reaction type Task
Unknown (test sample) m
No-template control D

Note: You can define and setup standards in the Targets table: Select the
task of [=] Standard, then enter the quantity for that target.

8. (Optional) Define and assign biological replicate groups in the Advanced Setup
pane of the Plate tab.

a. In the Biological Replicates Groups table, enter a name and select a color for
each biological replicate group.

b. Select wells, then select the checkbox of a biological replicate group to assign
it to the selected well(s).

The target(s) of interest and the endogenous control target should each have wells
assigned with standard dilutions, unknown, and no-template-control tasks, and
corresponding samples.

In the Advanced Setup pane of Plate tab, ensure the Samples table contains:
* One sample for each dilution of an unknown sample
* Reference sample

* (Optional) A standard sample for each endogenous control target and target of
interest

Set up a Comparative C; experiment in the software

1. In the Home screen, create or open an experiment.
2. In the Properties tab, enter the information for the experiment.

3. In the Method tab, enter the reaction volume for the experiment.

For most experiments, the default run method is appropriate.

4. Define and assign well attributes in the Quick Setup pane of the Plate tab.
a. Select wellsinthe  Plate Layout or the ~ Well Table.

b. Assign samples and targets to selected wells.
* Enter new sample and target names in their respective fields.
® Select previously defined samples and targets from their respective
drop-down lists.

Note: When you enter a new sample or target name in the Quick Setup
pane, the software automatically populates default values for Reporter
(FAM) and Quencher (NFQ-MGB) and assigns the task ([I] Unknown).
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To change these default values, click Advanced Setup (see “Define samples
and targets or SNP assays” on page 11 or “Sample, target, and SNP assay
libraries” on page 84).

5. Assign plate attributes in the Quick Setup pane of the Plate tab.

a. In the Plate Attributes group, select a Passive Reference, Reference Sample,
and Endogenous Control from their respective drop-down lists.

6. (Optional) Assign tasks in the Advanced Setup pane of the Plate tab.
a. Select wellsinthe  Plate Layout or the =~ Well Table.

b. In the Targets table, select the checkbox of a target, then select a task from
the drop-down list.

Reaction type Task
Unknown [test sample) m
No-template control N |

7. (Optional) Define and assign biological replicate groups in the Advanced Setup
pane of the Plate tab.

a. In the Biological Replicates Groups table, enter a name and select a color for
each biological replicate group.

b. Select wells, then select the checkbox of a biological replicate group to assign
it to the selected well(s).

The target(s) of interest and the endogenous control target should each have wells
assigned with unknown and no-template-control tasks, and corresponding samples.

In the Advanced Setup pane of Plate tab, ensure the Samples table contains:
¢ Unknown samples

* Reference sample

Set up and run the PCR reactions

1. Assemble the PCR reactions, following the manufacturer's instructions for the
reagents, and following the plate layout set up in the software.

2. In the desktop software, open the appropriate experiment (.edt) file.
3. Load the reaction plate into the instrument and start the run.

See also:
* “Prepare reactions” on page 17

* “Run an experiment from the desktop software” on page 19
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General Relative Standard Curve c tive C i ent
workflows for experiment omparative Cr experimen
analY_5|5 of View the Amplification Plot to confirm or correct threshold and
Relative Standard baseline settings (page 25)
Curve and v
Comparative Ct
experiments Assess the Standard Curve Plot v
(page 43)
v

Review data for outliers and omit, if necessary (page 29)

v

Assess the Gene Expression Plot (page 55)

v

(Optional/View the Endogenous Control Profile using the QC Plot
(page 56)

v

[Optional/View the Multicomponent Plot (page 31)
v

[Optional/View the Raw Data Plot (page 33)
v

[Optional) Review flags in the QC Summary (page 34) adjust the
analysis settings (pages 34, 57)

v

[Optional/ Configure the analysis settings (pages 34, 57)

IMPORTANT! After omission of outliers or configuration of analysis settings, click
Analyze to reanalyze the experiment.
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This section only applies to Relative Standard Curve experiments.

About the Standard Curve Plot

The Standard Curve Plot displays the standard curve for samples designated as
standards. The software calculates the quantity of an unknown target from the

standard curve.

Table 12 Results to evaluate in the Standard Curve Plot

Result Description Criteria for evaluation
Slope and The amplification efficiency is calculated | A slope close to -3.3 indicates optimal, 100% PCR
amplification | using the slope of the regression line in amplification efficiency.
efficiency the standard curve. Factors that affect amplification efficiency:
¢ Range of standard quantities - For accurate and
precise efficiency measurements, use a broad range
of standard quantities, 5 to 6 logs (10°- to 106-fold).
¢ Number of standard replicates - For accurate
efficiency measurements, include replicates to
decrease the effects of pipetting inaccuracies.
¢ PCRinhibitors - PCR inhibitors in the reaction can
reduce amplification efficiency.
RZ value The R? value is a measure of the closeness | ® Avalue of 1.00 indicates a perfect fit between the
(correlation | of fit between the regression line and the regression line and the data points.
coefficient) individual Ct data points of the standard e An RZvalue >0.99 is desirable.
reactions.
Error The standard error of the slope of the Acceptable value is determined by the experimental
regression line in the standard curve. criteria.
The error can be used to calculate a
confidence interval (Cl) for the slope and
therefore the amplification efficiency.
Cy values The threshold cycle (Cq) is the PCR cycle A Ctvalue >8 and <35 is desirable.
number at which the fluorescence level e ACyvalue <8 indicates that there may be too much
meets the threshold. template in the reaction.
e A Cyvalue >35 indicates a low amount of target in
the reaction; for Cy values >35, expect a higher
standard deviation.
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View and assess the Standard Curve Plot

In the Results tab:

If no data are displayed, click Analyze.

1.

2.

Select Standard Curve from the drop-down list.

Click  to configure the plot:

e Target: select the target of interest
e Plot Color: FLAG-STATUS, SAMPLE, TARGET, or TASK
* Selectall wellsinthe  Plate Layout

The Standard Curve Plot is displayed. The slope, R? value, amplification
efficiency, and error are displayed below the plot.

Confirm that the slope, R? value, amplification efficiency, and error meet the
experimental criteria.

Visually check that all unknown sample Cr values fall within the standard curve
range.

Inthe  Well Table, use the Group By drop-down list to confirm that the Ct
values of all replicate samples meet the experimental criteria.

Figure 11 Example Standard Curve Plot

If the experiment does not meet the guidelines above, troubleshoot as follows:

* Omit wells (see “Omit outliers from analysis” on page 29).

or

* Repeat the experiment, adjusting the experimental setup to improve results.

See also “About the Standard Curve Plot” on page 42.
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About the Standard Curve settings

You can use the standard curve from another experiment and apply it to the current
experiment. The two experiments must be from the same instrument type, block type,
and run method. Use the Standard Curve Settings tab in the £# Analysis Settings to
import an external standard curve.

Refer to the software Help system for step-by-step instructions for adjusting the
Standard Curve settings.

The Gene Expression Plot displays the results of relative quantification calculations
for Relative Standard Curve and Comparative Ct experiments.

The purpose of reviewing the Gene Expression Plot is to evaluate the fold change in
expression level of the target(s) of interest in the test samples relative to the reference
sample.

There are two plots available, depending on the experimental focus. Each plot can be
viewed on a linear, logo, Ln, and log; scale.

Table 13 Gene Expression plots

Plot type Description

RQ vs Target Groups the relative quantification (RQ) values by target.
Each sample is plotted for each target.

RQ vs Sample Groups the relative quantification (RQ) values by sample.
Each target is plotted for each sample.

Figure 12 Example Gene Expression Plot

In this example, there is one target of interest, and the sample Unk_800 is the reference sample
(calibrator).
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About the QC Plot

56

The QC Plot is a visual display of the Cr levels of potential endogenous control targets
across all samples (Endogenous Control Profile). The QC Plot serves as a tool to help
users choose the best endogenous control(s) for an experiment by choosing the target
whose quantity (indicated by Ct value) does not change under experimental
conditions.

All targets can be displayed in the QC Plot. You can view up to four potential
endogenous controls at a time.

View and assess the QC Plot

In the Results tab:

If no data are displayed, click Analyze.

1.

2.

Select QC Plot from the drop-down list.

In the right-side pane, select the target(s) to display, then select the color and
shape from the drop-down lists.

(Optional) In the View Replicate Results Table tab, select the samples to omit from
analysis.

(Optional) To change the endogenous control(s) used for analysis, select $gf
» Relative Quantification Settings (see “About relative quantification
settings” on page 57).

Figure 13 Example QC Plot

Click Analyze to see the result of the adjustments.
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Select Results » £} » Relative Quantification Settings to change these parameters:

quantification

. Parameter
settings

Description

Analysis Type

Select Multiplex or Singleplex analysis.

Reference(s)

Set the reference sample, or set a biological replicate
group as the reference sample.

Endogenous Control(s)

Change the endogenous control, or select multiple
endogenous controls.

Efficiency

(Comparative Cr
experiments only))

Set the amplification efficiency for a target.

The amplification efficiency for each target is calculated
from the standard dilution series in Relative Standard
Curve experiments.

Outlier Rejection

[multiplex reactions only))

Outliers with ACt values less than or equal to the entered
value are rejected.

RQ Min/Max Calculations

Determines the algorithm used to calculate the relative

quantification minimum and maximum values (error bars).

e Confidence Level: Select to calculate the RQ

minimum and maximum values based on the selected

confidence level.
e Standard Deviations: Select to calculate the RQ

minimum and maximum values based on the selected

number of standard deviations.

Refer to the software Help system for step-by-step instructions for adjusting the
relative quantification settings.
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About Genotyping experiments

Overview Genotyping experiments are used to detect single nucleotide polymorphism (SNP)
variants of a target nucleic acid sequence.

™

Genotyping experiments use preformulated TagMan™ SNP Genotyping Assays that
include:

¢ Two sequence-specific primers for amplification of sequences containing the SNP
of interest.
e Two allele-specific TagMan™ probes for Allele 1 and Allele 2.
In a Genotyping experiment:
1. The software normalizes the fluorescence of the reporter dyes to the fluorescence
of the passive reference dye in each well.

2. The software plots the normalized intensities (Rn) of the reporter dyes in each
sample well on an Allelic Discrimination Plot, which contrasts the reporter dye
intensities of the allele-specific probes.

3. The software algorithmically clusters the sample data, and assigns a genotype
call to the samples of each cluster according to its position on the plot.
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Reaction types Table 14 Reaction types for Genotyping experiments
Reaction type (task) Sample description
Unknown Test sample
No-template control Water or buffer

No amplification of the target should occur in NTC wells.

Allele control (1/1) Control sample that is homozygous for allele 1
Allele control (1/2) Control sample that is heterozygous allele 1/allele 2
Allele control (2/2) Control sample that is homozygous for allele 2

Allele controls are optional but recommended. Including allele controls helps to
improve the clustering algorithm, particularly in situations where a limited number of
samples are run.

In Genotyping experiments, the software makes calls for individual wells. Running 3
or more replicates of each reaction can help identify outlier wells that may be present.

Compatible PCR Table 15 PCR options for Genotyping experiments
options
Single- or multiplex PCR PCR or RT-PCRI" Reagent system
Multiplex? PCR TagMan™

[ RT-PCR: reverse transcription PCR

(2 Each SNP Genotyping assay is a multiplex assay with a probe for each allele. Multiple SNP assays can be
performed in a single well.

Genotyping calls are based on end-point data, that is, data collected after the PCR is
completed.

* The data collected is the normalized intensity of the reporter dye, or Rn.

¢ If end-point experiments include pre-PCR data points, the software calculates the
delta Rn (ARn) value according to the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized readings.

We recommend collecting real-time amplification data during the PCR, for
troubleshooting purposes.

Set up a Genotyping experiment in the software

Only Genotyping experiments contain SNP assay options.
Note:

1. In the Home screen, create or open an experiment.
2. In the Properties tab, enter the information for the experiment.

3. In the Method tab, enter the reaction volume for the experiment.

For most experiments, the default run method is appropriate.
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4. Define and assign well attributes in the Quick Setup pane of the Plate tab.
a. Select wellsinthe  Plate Layout or the =~ Well Table.

b. Assign samples and SNP assays to selected wells.
* Enter new sample and SNP assay names in their respective fields.
* Select previously defined samples and SNP assays from their respective
drop-down lists.

Note: When you enter a new sample or SNP assay name in the Quick Setup
pane, the software automatically populates the following default values:

Allele 1 | Reporter | Quencher | Allele2 | Reporter | Quencher Task

Allele 1 VIC NFQ- Allele 2 FAM NFQ- m
MGB MGB Unknown

To change these default values, click Advanced Setup (see “Define samples
and targets or SNP assays” on page 11 or “Sample, target, and SNP assay
libraries” on page 84).

5. Assign plate attributes in the Quick Setup pane of the Plate tab.

a. In the Plate Attributes group, select the Passive Reference from the drop-
down list.

6. (Optional) Assign tasks in the Advanced Setup pane of the Plate tab.
a. Select wellsin the  Plate Layout orthe = Well Table.

b. Inthe SNP Assays table, select the checkbox of a SNP assay, then select a
task from the drop-down list.

Reaction type Task

Unknown (test sample)

No-template control
Allele control (1/1)1]
Allele control (1/2)1)
Allele control (2/2)1]

MNEEEE

01" Optional but recommended

In the Advanced Setup pane of Plate tab, ensure the Samples table contains:
* Unknown samples

* (Optional) Allele control samples
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Set up and run the PCR reactions

1. Assemble the PCR reactions, following the manufacturer's instructions for the
reagents, and following the plate layout set up in the software.

2. In the desktop software, open the appropriate experiment (.edt) file.
3. Load the reaction plate into the instrument and start the run.

See also:
* “Prepare reactions” on page 17

* “Run an experiment from the desktop software” on page 19

Review results

General workflow Assess the Allelic Discrimination Plot (page 62)
for analysis of v
Genotyping

[Optional/View the Amplification Plot (page 25)
v

experiments

Review data for outliers and omit, if necessary (page 29)

v

(Optional/View the Multicomponent Plot (page 31)
v

(Optional/View the Raw Data Plot (page 33)
v

[Optional/ Review flags in the QC Summary (page 34)
v

[Optional] Configure the analysis settings (pages 34, 64)

IMPORTANT! After omission of outliers or configuration of analysis settings, click
Analyze to reanalyze the experiment.
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About the Allelic
Discrimination
Plot

View and assess
the Allelic
Discrimination
Plot

62

The Allelic Discrimination Plot contrasts the normalized intensities (Rn) of the
reporter dyes for the allele-specific probes of the SNP assay. It is an intermediary step
in the software algorithm for genotyping calls.

Data points tend to cluster along the horizontal axis (Allele 1), vertical axis (Allele 2),
or diagonal (Allele 1/Allele 2).

Table 16 Data clusters in the Allelic Discrimination Plot

A substantial increase in... Clusters along... Indicates...
VIC™ dye-labeled probe Horizontal axis Homozygosity for Allele 1
fluorescence only
FAM™ dye-labeled probe Vertical axis Homozygosity for Allele 2
fluorescence only
Both VIC" and FAM™ dye- Diagonal Allele 1-Allele 2
labeled probes fluorescence heterozygosity

View the allelic discrimination plot to:
¢ Confirm that clustering of control samples is as expected.

¢ Visually assess clusters for the three possible genotypes.

Note: The desktop software clustering algorithm does not call genotypes if all the
samples are one genotype (form one cluster). In this case, use the Applied
Biosystems™ Genotyping Analysis Module [gf in the Thermo Fisher Cloud.

In the Results tab:

If no data are displayed, click Analyze.

1. Select Allelic Discrimination Plot from the drop-down list.

2. Click to configure the plot:
* SNP Assay: select the assay of interest
* Plot Type: Cartesian or Polar
The Allelic Discrimination Plot is displayed for the selected SNP assay.

Note: Initially, all points in the plot are cyan because all of the wells in the
Plate Layout are selected. Click anywhere in the plotor ~ Plate Layout to
deselect all wells. The data points in the plot change to the call colors.

3. Confirm that control data clusters as expected.

a. In the well table or plate layout, select the wells containing a control to
highlight the corresponding data points in the Allelic Discrimination Plot.

b. Check that the data points for each genotype control cluster along the
expected axis of the plot.
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Select the cluster at the bottom-left corner of the plot, and confirm that only the
negative control wells are selected in the =~ Plate Layoutor =~ Well Table.

Samples that unexpectedly cluster with the negative controls may:
¢ Contain no DNA.
¢ Contain PCR inhibitors.

* Be homozygous for a sequence deletion.

Review the other clusters in the plot.

a. Click and drag a box around a cluster to select the associated wells.

b. Confirm that the expected wells are selected in the ~ Plate Layout or
Well Table.

Look for outliers outside the three genotype clusters.

Figure 14 Example Allelic Discrimination Plot

To confirm results, retest outliers and samples with no amplification (cluster with
negative controls).

Perform manual 1.
calls
2.
3.
4,
5.

Open a Genotyping experiment that contains results data.

In the Results tab, select Allelic Discrimination Plot from the drop-down list.
If the data are not analyzed, click Analyze.

Click to display the plot menu bar.

(For multiple assays only) Select a SNP assay from the drop-down list.
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6. In the Allelic Discrimination Plot, click-drag to select the sample(s) to be
manually called.
7. Click , then select the allele call from the Apply Call drop-down list.

8. Click Analyze.

IMPORTANT! To maintain manual calls after reanalysis, select -ﬂ- » Call
Settings, then deselect Default Settings and select Keep Manual Calls from
Previous Analysis.

Note: To remove manual calls, select £gf » Call Settings, deselect Keep Manual
Calls from Previous Analysis, then reanalyze.

About call settings Use the Call Settings tab in the -ﬂ- Advanced Settings to:
for Genotyping * Change the default data analysis settings.

experiments * Edit the default call settings (for SNP assays without custom call settings) or
custom call settings for individual SNP assays.

Table 17 Data analysis settings options for Genotyping experiments

Data analysis setting Description
Analyze Data from Post-PCR Read Only Only post-PCR read data is used to determine calls.
Analyze Data from Pre-PCR Read and Post-PCR | The pre-PCR read is subtracted from the post-PCR read to
Read!"! determine calls.
Analyze Real-Time Rn Data? The normalized reporter data (Rn) from the last cycle of the

cycling stage is used to determine calls.

Analyze Real-Time Rn - Median (Rna to Rnb){231 | A quick baseline-subtracted Rn from the last cycle of the cycling
stage is used to determine calls. The quick baseline-subtracted
Rn is the Rn minus the median value of the baseline region

The median subtraction provides improved data accuracy.

Analyze Real-Time dRn Data? The regular ARn (dRn] from the last cycle of the cycling stage is
used to determine calls. The ARn is calculated by subtracting the
best-fit line through the baseline region.

This method is better if the baselines are not flat.

01 The run method must include a pre-read stage.
[2I' Data collection must be on during the PCR stage.
Bl Rna to Rnb refers to all the cycles from the Start Cycle Number to the End Cycle Number of the baseline region.
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Review results
Table 18 Call settings for Genotyping experiments
Call setting Description

Autocaller Enabled The autocaller algorithm is used to make genotype calls.

Keep Manual Calls from Previous Analysis If autocaller is enabled, maintains manual calls after reanalysis.

Quality Value The Quality Value is a proprietary estimation of the likelihood that
a genotyping call is correct (associated with the correct cluster].
If the Quality Value is less than the setting, the call is
undetermined.

Refer to the software Help system for step-by-step instructions for adjusting the call
settings.
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About Presence/Absence experiments

Overview

66

Presence/Absence experiments are used to determine the presence or absence of a
target nucleic acid sequence in a sample.

The software calls the target present or absent based on an algorithmically determined
call threshold. (The call threshold is different from the Ct threshold; the Ct threshold
is not used to make calls.)
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Reaction types

About Presence/Absence experiments

Presence/Absence reaction types depend on whether the experiment is set up with or

without an internal positive control (IPC).

* Presence/Absence experiments with IPC (recommended) are multiplex assays
for the target of interest and the IPC target. The IPC is used to confirm that a
negative result for the target of interest is not caused by a failed PCR.

Table 19 Reaction types for Presence/Absence experiments with IPC

Reaction type (task)

Sample description

Unknown

Test sample
and
IPC template

Negative control

Water or buffer
and
IPC template

No amplification control
(NAC; blocked IPC)I

Water or buffer plus a blocking agent
and
IPC template; amplification prevented by blocking agent

M Minimum of two replicates is required for this control.

* Presence/Absence experiments without IPC are singleplex reactions.

Table 20 Reaction types for Presence/Absence experiments without IPC

Reaction type (task)

Sample description

Unknown

Test sample

Negative control

Water or buffer

The software makes calls for individual wells. Running three or more replicates of
each reaction can help identify outlier wells that may be present.

Compatible PCR
options

Table 21 PCR options for Presence/Absence experiments

Single- or multiplex PCR

PCR or RT-PCRI" Reagent system

Singleplex (without IPC)
Multiplex (with IPC)

PCR TagMan™
1-step RT-PCR
2-step RT-PCR

[ RT-PCR: reverse transcription-PCR

Presence/absence calls are based on end-point data, that is, data collected after the

PCR is completed.

e The data collected is the normalized intensity of the reporter dye, or Rn.

¢ If end-point experiments include pre-PCR data points, the software calculates the
delta Rn (ARn) value according to the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized readings.

We recommend collecting real-time amplification data during the PCR, for

troubleshooting purposes.
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Set up the Presence/Absence experiment in the software

Set up the Presence/Absence experiment in the software

1. In the Home screen, create or open an experiment.
2. In the Properties tab, enter the information for the experiment.

3. In the Method tab, enter the reaction volume for the experiment.
For most experiments, the default run method is appropriate.

4. Define and assign well attributes in the Quick Setup pane of the Plate tab.
a. Select wellsinthe  Plate Layout or the = Well Table.

b. Assign samples and targets to selected wells.
* Enter new sample and target names in their respective fields.
* Select previously defined samples and targets from their respective
drop-down lists.

Note: When you enter a new sample or target name in the Quick Setup
pane, the software automatically populates default values for Reporter
(FAM) and Quencher (NFQ-MGB) and assigns the task ([I] Unknown).

To change these default values, click Advanced Setup (see “Define samples
and targets or SNP assays” on page 11 or “Sample, target, and SNP assay
libraries” on page 84).

5. Assign plate attributes in the Quick Setup pane of the Plate tab.

a. In the Plate Attributes group, select the Passive Reference from the drop-
down list.

6. (Optional) Assign tasks in the Advanced Setup pane of the Plate tab.
a. Select wellsinthe  Plate Layout or the =~ Well Table.

b. In the Targets table, select the checkbox of a target, then select a task from
the drop-down list.

Reaction type Target Task

Target of interest

Unknown [test sample)
IPC

Target of interest

Negative control
IPC

Target of interest

IPC

NAC (blocked IPC]

NEHEERE
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Set up and run the PCR reactions

Set up and run the PCR reactions

1. Assemble the PCR reactions, following the manufacturer's instructions for the
reagents, and following the plate layout set up in the software.

2. In the desktop software, open the appropriate experiment (.edt) file.
3. Load the reaction plate into the instrument and start the run.

See also:
* “Prepare reactions” on page 17

* “Run an experiment from the desktop software” on page 19

Review results

General workflow Assess the Presence/Absence Plot (page 70)
for analysis of v
Presence/Absence

[Optional/View the Amplification Plot (page 25)
v

experiments

Review data for outliers and omit, if necessary (page 29)

v

(Optional/View the Multicomponent Plot (page 31)
v

(Optional/View the Raw Data Plot (page 33)
v

[Optional/ Review flags in the QC Summary (page 34)
v

[Optional] Configure the analysis settings (pages 34, 72)

IMPORTANT! After omission of outliers or configuration of analysis settings, click
Analyze to reanalyze the experiment.
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Review results
About the The Presence/Absence Plot displays the intensity of the fluorescence for each well
Presence/Absence  Position.

Plot

The purpose of viewing the Presence/Absence Plot is to confirm that amplification in
the control wells is as expected and to view the calls for the unknown samples.

Table 22 Expected results for control reactions

Reaction type

Target

Result

Call

Negative control

IPC

Amplification

IPC Succeeded

Target of interest(!

No amplification

Negative control

NAC (blocked IPC)

Ipct

No amplification

Blocked IPC Control

Target of interest

No amplification

Negative control

0 The target threshold is calculated from the negative control reactions.
(2l The IPC threshold is calculated from the NAC reactions.

Table 23 Criteria for calls in unknown reactions

Target signal IPC Signal Call
Above the target threshold Above orbelow the IPC threshold Presence
Below the target threshold Above the IPC threshold Absence

Below the target threshold Below the IPC threshold

Unconfirmed

View and assess In the Results tab:

the If no data are displayed, click Analyze.
Presence/Absence
Plot 1. Select Presence/Absence Plot from the drop-down list.

2. Click to configure the plot:

¢ Target Reporter: target defined for the target of interest
¢ Control Reporter: target defined for the IPC

e For initial view of the Presence/Absence Plot, select:
— Show Calls: All Calls

— Show IPC
— Show Controls

The Presence/Absence Plot is displayed for data points selected in the plot
settings. The data points for selected wells in the  Plate Layout or Well
Table are highlighted in the plot (see Figure 15).
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Review results

3. Confirm that amplification in the negative and blocked IPC control wells is as
expected.

* Select control wells in the  Plate Layoutor = Well Table, then confirm the
location of the data points in the Presence/Absence Plot.

e Inthe Well Table, select Group By » Task, then examine the wells with the
Blocked IPC ([A) and NTC ([])) tasks. The Cr values should be
Undetermined.

* View the amplification plots for the negative controls (see Figure 16 and
“Optimize display of negative controls in the Amplification Plot” on page 29).

4. In the Presence/Absence Plot, view the signal intensity and calls for the unknown
samples.

Use the plot settings (click ) to filter out the IPC results and control wells, or to
select only one type of call.

Figure 15 Example Presence/Absence Plot
The IPC results have been filtered out in this example.
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Review results

Figure 16 Example Amplification Plot for negative control and blocked IPC

Amplification of the IPC target (blue lines) is seen in the negative control wells but not the
blocked IPC (NAC) wells. No amplification of the target of interest (red lines) is seen in either
negative control or blocked IPC wells.

About call settings  Use the Call Settings tab to:

for e Change the default data analysis settings.
Prese.nce/Absence Data Analysis Settings option Description
experiments
Analyze Data from Post-PCR Only post-PCR read data is used to determine
Read Only calls.
Analyze Data from Pre-PCR The pre-PCR read is subtracted from the post-
Read and Post-PCR Read PCR read to determine calls.

* Edit the default call settings (for assays without custom call settings) or custom
call settings for individual assays.

Call setting Description

Confidence Value Select the confidence value used to determine the
target and IPC call thresholds.

- Alower confidence value or more controls
typically results in a lower calculated
threshold.

- Ahigher confidence value or fewer controls
typically results in a higher calculated
threshold.

Refer to the software Help system for step-by-step instructions for adjusting the call
settings.
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About Melt Curve experiments

Overview

Reaction types

The Melt Curve experiment is used to determine the melting temperature (Tm) of the

™

amplification products of a PCR reaction that used SYBR™ Green dye.

Melting temperature (Tm) is the temperature at which 50% of the DNA is double-
stranded and 50% is dissociated into single-stranded DNA. The melt curve of a single
amplification product displays a single peak at the product's Tm. Multiple peaks in a
melt curve experiment indicate additional amplification products, usually from non-
specific amplification or formation of primer-dimers.

In the software, Melt Curve analysis is included in the default run method for any
experiment type that uses SYBR™ Green reagents.

Table 24 Reaction types for Melt Curve experiments

Reaction type (task) Sample description

Unknown Previously run PCR reactions that used SYBR" Green
reagents

No-template control (NTC) | Previously run PCR reactions that used water or buffer

Note: No DNA should be present in NTC wells.
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Set up a Melt Curve experiment in the software

Set up a Melt Curve experiment in the software

1. In the Home screen, create or open an experiment.
2. In the Properties tab, enter the information for the experiment.

3. In the Method tab, enter the reaction volume for the experiment.

(Optional) Edit the ramp increment in the melt curve (see “Edit the ramp
increment for the Melt Curve dissociation step” on page 82).

4. Define and assign well attributes in the Quick Setup pane of the Plate tab.
a. Select wellsinthe  Plate Layout or the = Well Table.

b. Assign samples and targets to selected wells.
* Enter new sample and target names in their respective fields.
* Select previously defined samples and targets from their respective
drop-down lists.

Note: When you enter a new sample or target name in the Quick Setup
pane, the software automatically populates default values for Reporter
(FAM) and Quencher (NFQ-MGB) and assigns the task ([I] Unknown).

To change these default values, click Advanced Setup (see “Define samples
and targets or SNP assays” on page 11 or “Sample, target, and SNP assay
libraries” on page 84).

5. Assign plate attributes in the Quick Setup pane of the Plate tab.

a. In the Plate Attributes group, select the Passive Reference from the drop-
down list.

6. (Optional) Assign tasks in the Advanced Setup pane of the Plate tab.
a. Select wellsinthe  Plate Layout or the =~ Well Table.

b. In the Targets table, select the checkbox of a target, then select a task from
the drop-down list.

Reaction type Task
Unknown [test sample) m
No-template control N |
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Set up Melt Curve reactions

Set up Melt Curve reactions

Melt Curve experiments are performed using previously amplified PCR products,
usually at the end of the PCR run method. You can also use plate from a
SYBR ~ Green-based PCR run on another instrument.

Review results

General workflow Assess the Melt Curve Plot (page 76)

for analysis of v

Melt Curve

experiments (Optional/View the Multicomponent Plot (page 31)
v

(Optional/View the Raw Data Plot (page 33)
v

[Optional] Review flags in the QC Summary (page 34)
v

[Optional] Configure the analysis settings (pages 34, 77)

IMPORTANT! After omission of outliers or configuration of analysis settings, click
Analyze to reanalyze the experiment.

About the Melt The Melt Curve Plot displays the melt curve of the amplification products in the
Curve Plot selected wells.

The purpose of viewing the Melt Curve Plot is to confirm that the amplification
products in a well display a single melting temperature (Tm). Multiple peaks in a melt
curve indicate non-specific amplification or primer-dimer formation.

Table 25 Melt Curve plots

Plot Description

Derivative Reporter (-Rn’) Displays the derivative reporter signal in the y-axis.

vs. Temperature The peaks in the plot indicate significant decrease in

SYBR" Green signal, and therefore the Tm of the amplified
products. Use this plot to confirm a single Tm of the
amplification products.

Normalized Reporter (Rn) Displays the fluorescence signal from the reporter dye
vs. Temperature normalized to the fluorescence signal of the passive
reference, as a function of temperature.

You can use this plot to check the quality of the
fluorescence data.
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Review results

View and assess
the Melt Curve
Plot

76

In the Results tab:

If no data are displayed, click Analyze.

1. Select Melt Curve Plot from the drop-down list.

2. Click  to configure the plot:

Plot Type: Derivative Reporter
Color: Sample, Target, or Well
Target: All or a target of interest

(For custom experiments with more than one Melt Curve stage) Select the Melt
Curve stage to view.

The Melt Curve Plot is displayed for the selected wells of the selected stage.

3. Review the plot for evidence of unexpected multiple peaks, indicating non-
specific amplification or formation of primer-dimers.

4. Review the Well Table for the calculated Tm in each well.

Figure 17 Example Melt Curve Plot
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Review results

About Melt Curve Use the Melt Curve Settings tab to:
settings * Enable or disable Multi-Peak Calling.

Multi-Peak Calling

Description

Enabled

More than one PCR product is expected, to determine
the Tm for multiple peaks.

Disabled

Only one PCR product is expected.

* (For multi-peak calling only) Adjust the threshold peak level relative to the

dominant peak.

Specify a fractional level value as the additional peak detection threshold. The
detected peaks are measured relative to the height of the tallest peak, which has a
perfect fractional level of 100%. The default value is 10%.

For example, set a fractional level detection threshold value at 40, then peaks
above 40% of the tallest peak are reported, and peaks below 40% are regarded as

noise.

Refer to the software Help system for step-by-step instructions for adjusting the Melt

Curve settings.
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Appendix A Alternative procedures and shortcuts for setting up an ex-

Set up a custom experiment

About custom
experiments

™

periment
Set up a custom experiment

Custom experiment setup is required for assays that use multiple PCR stages, such as
TagMan ™ Mutation Detection Assays. The custom experiment also allows flexibility
for secondary analysis.

The default settings for custom experiments are that of a Standard Curve experiment,

but most settings are editable.

Table 26 Default for key settings in custom experiments

Setting

Default

Run method (thermal protocol)

Equivalent to Standard Curve experiment default

Tasks

Unknown [}
Negative control [ ]
Standard []]

Cr settings

Baseline Threshold equivalent to Standard Curve
experiment default

Flag settings

QC flags on

No automatic omissions

Auto Export

Off

Table 27 Key editing options in custom experiments

Item

Description

Run method (thermal
protocol)

Multiple instances of any type of stage can be added,
with exceptions noted.

Any stage can be added anywhere, with exceptions
noted.
Exceptions:
- Only one infinite hold, which must be only at the
end.

- Only one pre-PCR read and one post-PCR read
stage. If both exist in a run method, the pre-read
must be before the post-read.

For example, this order is valid: melt-PCR-Pre-Read-
Melt-PCR.
Ramp rates can be edited within software limits.

Data collection can be enabled at any step and during
any ramp within a melt stage.

Analysis settings Editable
Flags Editable
Filter channel Editable
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periment
Set up a custom experiment

Set up a custom 1. In the Home screen, create or open an experiment.
experiment in the In the P o5 tab he inf on for th .
software . In the Properties tab, enter the information tor the experiment.

3. In the Method tab, edit the default run method according to the experiment
requirements.

4. Define and assign well attributes in the Quick Setup pane of the Plate tab.
a. Select wellsin the  Plate Layout or the Well Table.

b. Assign samples and targets to selected wells.
¢ Enter new sample and target names in their respective fields.
* Select previously defined samples and targets from their respective
drop-down lists.

Note: When you enter a new sample or target name in the Quick Setup
pane, the software automatically populates default values for Reporter
(FAM) and Quencher (NFQ-MGB) and assigns the task ([I] Unknown).

To change these default values, click Advanced Setup (see “Define samples
and targets or SNP assays” on page 11 or “Sample, target, and SNP assay
libraries” on page 84).

5. Assign plate attributes in the Quick Setup pane of the Plate tab.

a. In the Plate Attributes group, select the Passive Reference from the drop-
down list.

6. (Optional) Assign tasks in the Advanced Setup pane of the Plate tab.
a. Select wellsinthe  Plate Layout or the =~ Well Table.

b. In the Targets table, select the checkbox of a target, then select a task from
the drop-down list.

7. (Optional) Define and assign biological replicate groups in the Advanced Setup
pane of the Plate tab.

a. In the Biological Replicates Groups table, enter a name and select a color for
each biological replicate group.

b. Select wells, then select the checkbox of a biological replicate group to assign
it to the selected well(s).
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periment
Adjust method parameters

Adjust method parameters

Method elements

Set up specialized
temperature
zones

See “Method elements” on page 81 for an overview of the method as it is graphically
represented.

In the Method tab:

Click a method parameter field to edit:

* Sample volume

* Ramp rate

e Step temperature
¢ Step hold time

* Number of cycles
Click-drag to quickly increase or decrease a step temperature.

Click  to switch data collection on or off at each step.
Data Collection On enables analysis of data collected throughout the PCR, for
real-time analysis and troubleshooting.

™

Click  to configure settings for Auto Delta or VeriFlex™ Zones for individual
steps (see “Set up specialized temperature zones” on page 81).

Note: In melt curve stages, Advanced Settings are not applicable.

M

An A or ' displays in the PCR stage when Auto Delta or VeriFlex™,
respectively, is enabled.

Click  to configure pause settings.

Adjust the cover temperature via the instrument settings (refer to the touchscreen
Help system).

Refer to the software Help system to:

* Add or subtract a stage
* Add or subtract a step from a stage

* Configure optical filter settings

Configure settings for Auto Delta and VeriFlex  Zones using ¥ (Advanced Settings).

The Auto Delta feature allows incremental increase or decrease of a cycle's

temperature at a step within a cycling stage (not applicable for Hold and Infinite Hold
stages).

VeriFlex ' Zones allow for independent temperature zones within 5°C of adjacent
zones: 3 zones for QuantStudio 3 Systems and 6 zones for QuantStudio 5 Systems.
VeriFlex ' Zones temperature settings are not available for 384-well blocks.
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periment
Edit the ramp increment for the Melt Curve dissociation step

In the Method tab:
1. Click £ within a step.
Note: Any changes apply only to the step in which you clicked.

2. Configure either the VeriFlex™ Zones or Auto Delta for the step.
e Select VeriFlex™, then enter a temperature for each zone.

Note: In the Plate tab, the VeriFlex™ Zones display on the plate layout.
. To view setting details, hover over the V in each of the zones.
. To hide the display of zones, select ~ Action » Hide VeriFlex" Zones.

* Select Auto Delta, then enter a starting cycle, temperature, and time.

3. Click Save.

Edit the ramp increment for the Melt Curve dissociation step

In the Method tab:

¢ Under the graphical representation of the thermal protocol, select the ramp
increment method for the dissociation step.

Option Description
Continuous (default) Continuously increases the temperature by the ramp
increment (°C/sec).
Step and Hold Increases the temperature by the ramp increment (°C),
then holds at that temperature for the specified time.
No. of Data Points per Increases the temperature by the ramp increment (°C)
Degree and collects the specified number of data points per

degree increased.

* (For all options) Edit the temperature ramp increment.

a. Click the ramp increment element in the Dissociation step.

b. Enter a value (default is 0.15 °C/s) or use the up/down arrows to set the
desired value.

* (Step and Hold only) Edit the hold time after each temperature increase.
a. Click in the time field next to Step and Hold.

b. Enter a value (default is 5 seconds) or use the up/down arrows to set the
desired value.

* (No. of Data Points per Degree only) Edit the number of data points to be collected
with each degree increase.

a. Click the number of data points element in the Dissociation step.

b. Enter a value (default is 10) or use the up/down arrows to set the desired
value.
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Assign the standard dilutions manually

Appendix A Alternative procedures and shortcuts for setting up an ex-

periment
Assign the standard dilutions manually

This procedure applies to Standard Curve and Relative Standard Curve experiments
only.

In the Plate tab:

1.

2.

Shortcuts for expe

Select wells in the

Plate Layout or

Well Table.

Select the check box for the target, select [5] from the drop-down list, then enter a

quantity.

Repeat to complete the standard dilution series.

riment setup

* Use sample and target or SNP assay definitions saved in a library (see “Sample,
target, and SNP assay libraries” on page 84).

e Import some or all of an experiment setup:

To

Action

Setup information

Import sample and well
assignments

Import a sample definition file
(page 86)

- Well number
- Sample name

- [Optional/Custom sample properties

Import samples, targets, and
well assignments

Import a plate setup file
(page 87)

Plate setup information:
- Well number
- Sample name
- Sample color
- Target name
- Dyes

- [Optional/ Other well information

Set up the plate layout in a
spreadsheet without saving to a
special format

or

Use a subset of the columns in
a plate layout spreadsheet

Paste from an *.xls file
(page 88)

Plate setup information, as above

Import complete experimental
setup

Create an experiment from a
template (page 89)

- Plate setup information, as above
- Reagent information

- Thermal protocol

- Analysis settings
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periment
Sample, target, and SNP assay libraries

Sample, target, and SNP assay libraries

About libraries Libraries contain saved information to reuse in future experiments.

The available libraries are:

¢ Dye Library

e Sample Library

¢ Target Library

* SNP Assay Library

* Analysis Settings Library
To access the libraries:

* In the menu bar, select Tools » (Library of choice)...
or

¢ In the Plate tab of an open experiment or template, select ~ Action » Import
from Library.

Apply a filter to You can filter the Sample, SNP assay, Target, and Analysis Settings Libraries.

search a library 1. Access a library of interest.

¢ In the menu bar, select Tools » (Library of interest).
or

¢ In the Plate tab of an open experiment or template, click Advanced Setup,
then select  Action » Import from Library.

2. Select a feature from the first drop-down list. Each column of the table is an
available feature.

3. Select a condition from the second drop-down list to define the feature. The
conditions will vary by feature.

4. Enter a value or text by which to filter.
5. Click Apply Filter.

The list narrows based on the filter applied.

Import to the In the Plate tab:
Sample Library 1. Click Advanced Setup.

2. Inthe Samples table, select ~ Action » Import from Library.
3. Select Import....

4. Navigate to and select a file, then click Import.
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periment
Sample, target, and SNP assay libraries

Import from the In the Plate tab:
Sample Library to 1

. . Click Advanced Setup.
the experiment

2. Inthe Samples table, select ~ Action » Import from Library.

3. (Optional) Import sample information from a file (see “Import to the Sample
Library” on page 84).

4. (Optional) Apply a filter to search for a specific sample (see “Apply a filter to
search a library” on page 84).

5. Select one or more samples, then click Add Selected.

Note: Shift-click or Ctl-click to select multiple samples.

Import to the Import target information from an assay information file (AIF) or library export file to
Target Library the Target Library.
In the Plate tab:

1. Click Advanced Setup.
2. Inthe Targets table, select ~ Action » Import from Library.
3. Click Import... or Import AIF...

4. Navigate to and select a target .txt or .xml file, then click Import.

Import from the In the Plate tab:
Target Library to 1

: . Click Advanced Setup.
the experiment

2. Inthe Targets table, select ~ Action » Import from Library.

3. (Optional) Import targets from an assay information file (AIF) or library export
file (see “Import to the Target Library” on page 85).

4. (Optional) Apply a filter to search for a specific target (see “Apply a filter to search
a library” on page 84).

5. Select one or more targets, then click Add Selected.
Note: Shift-click or Ctl-click to select multiple targets.
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periment

Assign samples using a sample definition file

Import to the SNP
Assay Library

Import from the

SNP Assay Library

to the experiment

Only Genotyping experiments contain SNP assay options.

Import SNP assay information from an assay information file (AIF) or exported
library file to the SNP Assay Library.

In the Plate tab:
1. Click Advanced Setup.
2. Inthe SNP Assays table, select ~ Action » Import from Library.
3. Click Import... or Import AIF....
4.

Navigate to and select a SNP assay file, then click Import.

Only Genotyping experiments contain SNP assay options.
In the Plate tab:

1. Click Advanced Setup.

In the SNP Assays table, select ~ Action » Import from Library.

(Optional) Import SNP assay information from an assay information file (AIF) or
library export file (see “Import to the SNP Assay Library” on page 86).

(Optional) Apply a filter to search for a specific SNP assay (see “Apply a filter to
search a library” on page 84).

Select a SNP assay in the table, then click Add Selected.
Note: Shift-click or Ctl-click to select multiple SNP assays.

Assign samples using a sample definition file

About sample
definition files

Create a sample
definition file

86

Import sample information from a sample definition file to include in the plate setup.
A sample definition file is a comma-delimited file (*.csv) or a tab-delimited text file
(*.txt) that contains the following setup information:

Well number
Sample name

(Optional) Custom sample properties

. In a spreadsheet program such as Microsoft™ Excel™, create the following

column headers:
e Well
* Sample Name
* (Optional) Column header names for up to 32 user-defined custom fields (for
example, Custom 1, Custom 2, etc.)

Enter the well number and sample name in the appropriate columns.
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information from a
sample definition
file

Appendix A Alternative procedures and shortcuts for setting up an ex-
periment
Assign samples and targets using plate setup files

3. (Optional) Enter the custom properties for the sample.

4. Save the file as a tab-delimited text file (.txt) or a comma-separated values file
(.csv).

Example setup files are provided with the software in:

<drive>:\Program Files (x86)\Applied BioSystems\QuantStudio
Design & Analysis Software\examples\User Sample Files,

where <drive> is the drive on which the software is installed.

1. In an open experiment, select File » Import Plate Setup.
2. Click Browse, navigate to a sample definition text file, then click Select.
3. Click Apply.

4. If the experiment already contains plate setup information, the software prompts
for the replacement of the plate setup with the data from the file. Click Yes to
replace the plate setup information.

The samples appear in the Samples table for the experiment. All samples and well
assignments in the experiment are replaced with those in the file. If defined, the
custom sample properties also appear in the Well Table of the Results tab and in
the  Plate Layout tooltips in both the Plate and Results tabs. The custom fields can
be exported with the results data.

Note: To modify custom sample properties information, edit the custom fields in the
sample definition file and import the file again. All of the sample information in the
experiment is replaced with the information in the new file.

Assign samples and targets using plate setup files

About plate setup
files

Import plate setup
data

Plate setup files contain setup information such as the well number, sample name,
sample color, target name, dyes, and other reaction plate contents.

Plate setup files can be exported from previously run experiments. For instructions on
exporting an experiment, see “Export experiments or results” on page 37.

Import the plate setup for a new experiment from an exported file with one of the
following formats:

* *.eds - EDS file format

* *edt- user-created and system templates files format

* *txt—text format

e *xml - XML format

* *.csv —comma separated values format

e *sdt - Sequence Detection System (SDS) template files format
* *sds—-7900 v2.4 format
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periment

Assign targets, samples, and biological replicate groups from an *.xls file

Note: Import plate setup information from a 96-well plate into a 384-well plate,
provided that the sample file is a .txt file.

IMPORTANT! The file must contain only plate setup data and it must match the
experiment type.

1. In the Plate tab, select File » Import Plate Setup.

2. Click Browse, navigate to and select the file to import, then click Select.
Example setup files are provided with the software in:

<drive>:\Program Files (x86)\Applied Biosystems\QuantStudio
Design & Analysis Software\examples\User Sample Files,

where <drive> is the drive on which the software is installed.

3. Click Apply.
The setup data from the selected file is imported into the open experiment.

Assign targets, samples, and biological replicate groups from an

* xls file

88

For wells with single targets, you can paste assignment information from an *.xls file
into the plate layout of the QuantStudio ~desktop Software.

An example copy and paste file is provided with the software in:

<drive>:\Program Files (x86)\Applied BioSystems\QuantStudio
Design & Analysis Softwarel\examples\User Sample Files.

where <drive> is the drive on which the software is installed.

™

1. In the custom properties tab of the example Microsoft™ Excel™ file, ensure that
the Well column is sorted in order 1 through 96, then select the Well column and
the Sample Name column, including headers.

2. In the Plate tab of the software, click Well Table, then ensure that the well
numbers are in order from 1 through 96.

3. Inthe Well Table, hover the mouse in the first cell underneath the Sample
header (adjacent to A1), right-click, then select either Paste or Paste only
samples.

Any of the columns not copied are treated as NULL values for those columns.
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Appendix A Alternative procedures and shortcuts for setting up an ex-
periment
Set up an experiment using templates

Set up an experiment using templates

About experiment Use templates to create experiments with the same parameters or with pre-existing
templates settings. Experiments can be saved as unlocked or locked (password-protected)
templates.

The information saved in an experiment template (.edt) file includes:

¢ Plate setup information (defined sample and targets or SNP assays, plate
assignment of samples and targets or SNP assays)

* Reagent information
* Run method (thermal protocol)
* Analysis settings
Example templates are provided with the software in:

<drive>:\Program Files (x86)\Applied Biosystems\QuantStudio
Design & Analysis Softwarel\templates,

where <drive> is the drive on which the software is installed.
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Appendix A Alternative procedures and shortcuts for setting up an ex-

periment

Set up an experiment using templates

Options for working with unlocked templates

To

Action

Create a new template (.edt
file) from a locked template
(.edt file)

1. Inthe Home screen, select Create New Experiment » Template.
2. Navigate to and select the template, then click Open.

In the new .edt file, all experiment parameters can be modified.

Save the experiment
parameters of an
experiment (.eds) file as an
unlocked template (.edt file)
for future runs

Open an .eds file in the desktop software.
2. Select File » Convert Experiment to Template....
3. Navigate to the desired location, enter a file name, then click Save.

Modify an existing template
(.edt file)

In the menu bar, select File » Open....
2. Navigate to and select the template [(.edt file), then click Open.

Modify the experiment parameters as needed; all experiment parameters can be
modified.

4. Save changes to the new template.
¢ [nthe menu bar, select File » Save As ....

e Inany tab, select U; Save » Save as....

Options for working with locked templates

To

Action

Create a new template (.edt
file) from a locked template
(.edt file)

1. In the menu bar, select File » Open...
2. Navigate to and select the locked template.
3. Click Open » Enter run experiment information » OK (no password required).

In the new .edt file, parameters that can be modified:

e Experiment properties: name, barcode, username, chemistry details, comments
e Sample names and assignments
e Export configuration

Save the experiment
parameters of an
experiment (.eds] file as a
locked template (.edt file)
for future runs

In the menu bar, select File » Save As Locked Template....
2. Enter and confirm a password, then click OK.

Navigate to the desired location, enter a file name, then click Save.

90
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periment
Set up an experiment using templates

To

Action

Modify an existing locked
template (.edt file)

Mowbd-

o

In the menu bar, select File » Open...
Navigate to and select the locked template.
Click Open » Edit, enter the password, then click OK.

Modify the experiment parameters as needed; all experiment parameters can be
modified.

In any tab, click O; Save to save changes to the existing locked template.

(Optional) Save the changes as a new locked template. A locked template cannot
be saved as an unlocked template.

e Inany tab, select U; Save » Save as..., then enter the password.
e Inthe menu bar, select File » Save As Locked Template....
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Powerontheinstrument ....... ... ... . i 92

Transfer files from the instrument

Power on the instrument

To power on the instrument from a powered-off state:

1. Touch anywhere on the touchscreen to determine if the instrument is in sleep
mode. If the home screen displays, the instrument is already powered on.

2. If the home screen does not display, power on the instrument by pressing the
switch on the rear panel.

s s — | S— — —]
 — —— —— —

s — —o——
e  — — —— —

g
h

=l
®

The instrument is ready to use when the home screen is displayed.
If left unattended (for about two hours), the instrument automatically enters sleep

mode (enabled by default) to conserve power. Refer to the touchscreen Help system
for step-by-step instructions for changing the sleep mode setting.
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Appendix B Supplemental information
Transfer files from the instrument

Transfer files from the instrument

If the instrument completes a run without a connection to the desktop software, the
experiment data must be manually transferred.

You can use a USB drive plugged into the front-panel USB port to transfer files.
In the instrument home screen:
Touch (%) Settings » Run History.

¢ Touch an individual run to view details, then touch Delete to delete the record, or
Transfer to export the experiment .eds file.

¢ Touch Manage to select multiple items for simultaneous viewing, deletion, or
transfer.

Guests (users not signed-in) can only view guest records. Users with instrument
profiles can also view their own records. Administrators can view all experiment
records.
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Parts and materials

Kits, consumables, and accessories

The following kits, consumables, and reagents are used with the QuantStudiom 3 and
5 Systems.

Unless otherwise indicated, all materials are available through thermofisher.com.

Note: Store ROI/Uniformity, Background, Dye, and RNase P plates at -20°C and use
them by the expiration date on the packaging. All other consumables can be stored at
room temperature.

Compatible reagents

To perform Recommended reagent kits Cat. no.
f;ﬁrcsﬁption SuperScript” VILO™ cDNA Synthesis Kit 4453650
TagMan™ PCR TagMan" Fast Advanced Master Mix 4LLLAL55T

TagMan" GTXpress Master Mix 4401892
TagMan" Fast Virus 1-Step Master Mix Lb44432
TagMan" Gene Expression Master Mix 4369016
TagMan" Genotyping Master Mix 4371355
TagMan" Universal Master Mix Il, with UNG 4440038
TagMan" RNA-to-CT" 1-Step Kit 4392938
SYBR" Green Fast SYBR™ Green Master Mix 4385612
PeR Power SYBR" Green PCR Master Mix 4367659
Power SYBR™ Green RNA-to-CT" 1-Step Kit 4389986
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Appendix C Parts and materials
96-Well (0.2-mL] consumables

96-Well (0.2-mL) consumables

384-well consumables

QuantStudio™ Design and Analysis desktop Software User Guide

Consumable Contents Cat. no.
MicroAmp" Optical 8-Cap Strip 300 strips 4323032
MicroAmp™ Optical 8-Tube Strip (0.2 mL) 125 strips 4316567
MicroAmp" Optical Tube without Cap (0.2 mL) 2000 tubes N8010933
MicroAmp™ 96-Well Tray/Retainer Set (blue) (for 0.2 mL) 10 sets 4381850
MicroAmp" Optical 96-Well Reaction Plate (0.2 mL) 10 plates N8010560
500 plates 4316813
MicroAmp" EnduraPlate” Optical 96-Well Reaction Plate 20 plates 4483343
with Barcode (blue] (0.2 mL)
MicroAmp™ Optical Adhesive Film Kit 1 kit 4313663
Calibration or instrument verification plate Cat. no.
96-Well Region of Interest (ROI) and Background Plates (2 plates) 4432364
QuantStudio™ 3 or 5 10-Dye Spectral Calibration Kit, 96-Well 0.2-mL A26343
96-Well 0.2-mL Spectral Calibration Plate 1 A26331
(containing FAM™, VIC™, ROX", and SYBR" dyes)
96-Well 0.2-mL Spectral Calibration Plate 2 A26332
(containing ABY", JUN"™, and MUSTANG PURPLE" dyes)
96-Well 0.2-mL Spectral Calibratioh Plate 3 A26333
(containing TAMRA™, NED", and Cy" 5 dyes)
96-Well 0.2-mL TagMan™ RNase P Instrument Verification Plate 4432382
Consumable Contents Cat. no.
MicroAmp" Optical 384-Well Reaction Plate with Barcode 50 plates 4309849
500 plates 4326270
1000 plates 4343814
MicroAmp" EnduraPlate™ Optical 384-Well Reaction 20 plates 4483285
Plate with Barcode (clear] 500 plates 1483273
MicroAmp™ Optical Adhesive Film Kit 1 kit 4313663
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Appendix C Parts and materials
96-Well Fast [0.7-mL] consumables

Calibration or instrument verification plate Cat. no.
384-Well Region of Interest (ROI) and Background Plates (2 plates) 4432320
QuantStudio™ 3 or 5 10-Dye Spectral Calibration Kit, 384-Well A26341
384-Well Spectral Calibration Plate 1
™ ™ ™ ™ ™ A26334
(containing FAM ', VIC ", ROX", TAMRA", and SYBR " dyes]
384-Well Spectral Calibration Plate 2
™ ™ ™ ™ 1 A26335
(containing ABY", JUN™, MUSTANG PURPLE", NED", and Cy" 5 dyes)
384-Well TagMan™ RNase P Instrument Verification Plate 4455280
96-Well Fast (0.1-mL) consumables
Consumable Contents Cat. no.
MicroAmp" Optical 8-Cap Strip 300 strips 4323032
MicroAmp" Optical Fast 8-Tube Strip (0.1 mL) 125 strips 4358293
MicroAmp™ Optical Fast Tube with Cap (0.1 mL) 1000 tubes 4358297
MicroAmp™ 96-Well Tray (blue) (for 0.1 mL) 10 trays 4379983
MicroAmp" Optical 96-Well Fast Reaction Plate (0.1 mL) 10 plates 4346907
MicroAmp" EnduraPlate™ Optical 96-Well Fast Reaction 20 plates 4481194
Plate with Barcode (clear] (0.1 mL)
500 plates 4483494
MicroAmp" Optical Adhesive Film Kit 1 kit 4313663
Calibration or instrument verification plate Cat. no.
96-Well Fast Region of Interest (ROI) and Background Plates (2 plates) 4432426
QuantStudio™ 3 or 5 10-Dye Spectral Calibration Kit, 96-Well 0.1-mL A26342
96-Well 0.1-mL Spectral Calibration Plate 1
™ ™ ™ ™ A26336
(containing FAM ", VIC ", ROX ", and SYBR " dyes
96-Well 0.1-mL Spectral Calibration Plate 2
™ ™ - A26337
(containing ABY ', JUN ", and MUSTANG PURPLE " dyes)
96-Well 0.1-mL Spectral Calibration Plate 3
" " , A26340
(containing TAMRA™, NED™, and Cy" 5 dyes)
96Well Fast TagMan™ RNase P Instrument Verification Plate 4351979
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QuantStudio” 3 and 5 Systems accessories

Appendix C Parts and materials
QuantStudio™ 3 and 5 Systems accessories

Accessory Contents Cat. no.
MicroAmp™ Multi-Removal Tool 1 tool 4313950
MicroAmp" Cap Installing Tool (handle style) 1 tool 4330015
MicroAmp" Optical Adhesive Film Kit 1 kit 4313663
MicroAmp™ Optical Adhesive Film 25 films 4360954

100 films 4311971
MicroAmpTM Adhesive Film Applicator S applicators 4333183
Real Time PCR Grade Water 10x 1.5 mL AM9935

tubes

Handheld Barcode Scanner 1 scanner 448842
High Power USB WiFi Module 1 module A26774

General-use materials and consumables

The following general-use materials and consumables are required to calibrate,
maintain, and operate the instrument. Unless indicated otherwise, all materials shown
below are available from major laboratory suppliers (MLS).

Material/consumable Source
Bleach, 10% solution MLS
Centrifuge with 96-well plate buckets MLS
Cotton or nylon swabs and lint-free cloths MLS
Ethanol, 95% solution MLS
Optical clear adhesive film for PCR MLS
Pipettors, 100-pL and 200-pL (with pipette tips) MLS
Powder-free gloves MLS
Safety glasses MLS
Screwdriver, flathead MLS
Tissue, lint-free MLS
Deionized water MLS

QuantStudio™ Design and Analysis desktop Software User Guide

97



Documentation and support

Related documentation

98

Publication

Document Description
number

QuantStudio™ 3 and 5 Real-Time MANO0010407 |Describes the QuantStudio” 3 and 5

PCR Systems Installation, Use, and Real-Time PCR Systems hardware

Maintenance Guide and software and provides
information on preparing, using,
maintaining, and troubleshooting
the system.

QuantStudio™ Real-Time PCR MAN0010422 | Describes the QuantStudio™ 3 and 5

System Help Real-Time PCR Systems
touchscreen and provides
procedures for configuration,
calibration, and performing a run.

QuantStudio™ Design and Analysis MANOO010409 |Describes how to use the

desktop Software Command-Line command-line interface of the

Application Guide QuantStudio™ Design and Analysis
desktop Software and provides the
procedure to automate the creation
of new experiment files and export
data from existing files.

QuantStudio™ Design and Analysis | MAN0010408 | Describes how to perform the six

desktop Software User Guide different experiments on the
QuantStudio” Design and Analysis
desktop Software

QuantStudio™ Design and Analysis | MAN0010415 | Describes the QuantStudio” Design

desktop Software Help and Analysis desktop Software and
provides procedures for common
tasks.

SAE Admin Console Help MANO0O10417 |Describes the Security, Audit, and
e-Signature (SAE) Administrator
Console and provides procedures
for common tasks.

SAE Admin Console User Guide MANO0O10410 |Describes how to use the Security,

Audit, and e-Signature (SAE)
Administrator Console.
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Documentation and support
Obtain information from the Help system

Publication
number

Document Description

QuantStudio™ Design and Analysis | MAN0010414 | Describes the QuantStudio™ Design
cloud Software Help and Analysis cloud Software and
provides procedures for common
tasks.

QuantStudio™ 3 and 5 Real-Time MANO0010405 | Explains how to prepare your site to
PCR Systems Site Preparation receive and install the

Guide QuantStudio™ 3 and 5 Real-Time
PCR Systems. Intended for
personnel who schedule, manage,
and perform the tasks required to
prepare the site for installation of
the QuantStudio™ 3 and 5 Real-
Time PCR Systems.

Note: For additional documentation, see “Customer and technical support” on
page 99.

Obtain information from the Help system

The software has a Help system that describes how to use each feature of the software.
Click (@) to access the Help system.

Customer and technical support

Visit thermofisher.com/support for the latest in services and support, including:
* Worldwide contact telephone numbers
e Product support, including;:
— Product FAQs
— Software, patches, and updates
¢ Order and web support
¢ Product documentation, including:
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.
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Documentation and support
Limited product warranty

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.thermofisher.com/us/en/home/global/
terms-and-conditions.html. If you have any questions, please contact Life
Technologies at www.thermofisher.com/support.
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biological
replicates

endogenous
control

endpoint read

post-PCR read

pre-PCR read

reference sample

target
task

technical
replicates

Glossary

Reactions that contain identical components and volumes, but evaluate separate
samples of the same biological source (for example, samples from three different mice
of the same strain, or separate extractions of the same cell line or tissue sample).

When an experiment uses biological replicate groups in a gene expression project, the
values displayed in the Biological Replicates tab are calculated by combining the
results of the separate biological samples and treating this collection as a single
population (that is, as one sample). For C; computations (normalizing by the
endogenous control) in a singleplex experiment, the software averages technical
replicates. The averages from the technical replicates are then averaged together to
determine the value for that biological replicate.

A gene that is used to normalize template differences and sample-to-sample or run-to-
run variation.

See post-PCR read.

In genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected
during the post-PCR read are displayed in the allelic discrimination plot and used to
make allele calls. In presence/absence experiments, fluorescence data collected during
the post-PCR read are displayed in the presence/absence plot and used to make
detection calls. Also called endpoint read.

In genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended.
Fluorescence data collected during the pre-PCR read can be used to normalize
fluorescence data collected during the post-PCR read.

In relative standard curve and comparative Cr (AACt) experiments, the sample used
as the basis for relative quantification results. Also called the calibrator.

The nucleic acid sequence that is amplified and detected during PCR.
In the software, the type of reaction performed in the well for the target.

Reactions that contain identical components and volumes, and that evaluate the same
sample; important for evaluating precision.
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Index

.edt and .eds file extensions 16 auto-analysis 24
automatic threshold 35

A

absolute quantity 38 B
accessories 97 Baseline Threshold algorithm 35
accurate dye signal, Multicomponent Plot 31 biological replicate group, assign to well 15
Advanced Setup 14 biological replicate groups, define 12
algorithm settings, Baseline Threshold 35 biological replicates
Allelic Discrimination Plot 62 assign 13
Amplification Plot define 11
baseline 26
baseline setting 28 c
exponential phase 26
linear phase 26 calibration data, override 36
optimize to view negative controls 29 column in .xIs file, well number 88
plateau phase 26 comma delimited file, for sample definitions 86
shape 26 Comparative CT experiments
threshold settings 26 analysis 52
analysis, workflow 24 compared to Relative Standard Curve 48
analysis settings endogenous control 47
about 34 Gene Expression Plot 55
advanced settings 34, 36 negative controls 47
configure 34 overview and purpose 47
flag settings 34, 36 PCR options 47
Melt Curve settings 77 QC Plot 56
Standard Curve settings 34 reaction types 47
Analysis Settings Library 84 reference genes 47
analyze relative quantification settings 57
Multicomponent Plot 31 replicates 47
QC Summary 34 set up in software 48, 50
Raw Data Plot 33 workflow 52
Standard Curve Plot 42, 53 consumables
Well Table 30 384-well 95
assign 96-well 0.1I-mL 96
biological replicate group 15 96-well 0.2-mL 95
sample 13,14 CT precision, improve 29
SNP assay 13, 14 CT settings
target 13,14 algorithm settings 35
task 13,14 default 35
assign standard dilutions 83 select data step 35
assign targets, samples, and biological replicates, tab 35
from .xIs file 88 target 35
Auto Delta, settings 81 custom experiments

about 79
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set up in software 80 H
Help system, access 99

D

define |
biological replicate group 12 identify well problems 30
samples 11 st ; 90
SNP assays 12 instrument, power on
targets 12

documentation, related 98 L

Dye Library 84 library, apply filter 84

limited product warranty 100
E load a plate 19

endogenous control locked templates 90

Comparative CT experiments 56

Relative Standard Curve experiments 56 M
example templates 89
experiment

adjust reaction volume 10

enter properties 10

export 37

setup 9

use default method 10
experiment data, import 87

Melt Curve experiments
analyze 75
overview and purpose 73
ramp increment 82
reaction types 73
reactions 75
set up in software 74

experiment template 89 Seﬁlﬁgs 7775
experiments, define parameters 11 workllow
export Melt Curve Plot
P about 75

experiment or results 37

. view and assess 76
experiments or results 37

method, create or edit 81
Multicomponent Plot

F accurate dye signal 31
confirm dye accuracy 31

fil 1
ename 16 view 31

G N
Gene Expression Plot
Comparative CT experiments 55
Relative Standard Curve experiments 55
RQ vs Sample 55 0
RQ vs Target 55
Genotyping experiments
Allelic Discrimination Plot 62
analysis 61
call settings 64 P
manual call 63
PCR options 59
Presence/Absence Plot 70
reaction types 59
set up in software 59
workflow 61

NULL values in well assignments 88

omit wells 29
online Help. See Help system

PCR options
Comparative CT experiments 47
Genotyping experiments 59
Presence/Absence experiments 67
Relative Standard Curve experiments 46
Standard Curve experiments 39

PCR reactions
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Index

guidelines for setup 17 QCPlot 56

handle samples and reagents 17 reaction types 46

prepare 17 relative quantification settings 57

setup and run 19, 41, 51, 61, 69 replicates 46
plate setup data, import 87 set up in software 48, 50
Presence/Absence experiments standard dilution series 46

analysis 69 workflow 52

call settings 72 required components

IPC 67 negative controls 39, 46, 59

overview and purpose 66 reference genes 46

PCR options 67 replicates 39, 59

reaction types 67 sample types 39, 59

set up in software 68 standard 39

workflow 69 standard dilution series 39
Presence/Absence Plot results, export 37

about 70 Results tab 22

view and assess 70 run history 93

Q S

QC Plot sample, assign to well 13, 14
Comparative CT experiments 56 sample definition file
Relative Standard Curve experiments 56 create 86
view and assess 56 spreadsheet 86
QC Summary sample information, import 86
review flags 34 Sample Library
view 34 import sample to the experiment 85
Quick Setup 13 import to 84
samples
assign 13
R define 11
Raw Data Plot select wells 13
determine signal accuracy 33 settings 81
signal accuracy 33 signal accuracy, Raw Data Plot 33
view and assess 33 SNP assay, assign to well 13, 14
reaction types SNP Assay Library
Comparative CT experiments 47 import from AIF or library export file 86
Genotyping experiments 59 import SNP assay to the experiment 86
Melt Curve experiments 73 SNP assays
Presence/Absence experiments 67 assign 13
Relative Standard Curve experiments 46 define 11,12
Standard Curve experiments 39 specialized temperature zones 81
reagents, enter information 10 standard 39, 46
related documentation 98 Standard Curve, use a different standard curve 44,
relative quantification, settings 57 55
relative quantity 45, 47 Standard Curve experiments
Relative Standard Curve experiments analysis 42
analysis 52 assign standard dilutions 83
assign standard dilutions 83 getting started 38
compared to Comparative CT 48 overview and purpose 38
endogenous control 46 PCR options 39
Gene Expression Plot 55 reaction types 39
overview and purpose 45 set up in software 40
PCR options 46 workflow 42
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Standard Curve Plot

view 42,53

view and assess 43, 54
Standard Curve settings 44, 55
startarun 19
SYBR® Green [ reagents 94

T

tab-delimited text file, for sample definitions 86
TagMan® reagents 94
target, assign to well 13, 14
Target Library
import from AIF or library export file 85
import target to the experiment 85
targets
assign 13

define 11,12
task, assign to well 13, 14
template, information saved 89
terms and conditions 100
thermal protocol, create or edit 81
transfer files 93

U

unlocked templates 90

W

warranty 100
Well Table 30
wells, select 13
workflow bar 10
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